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1 General Information

Read through this operating manual carefully before use and become familiar with the product.
Installation and start-up should not be carried out before reading and understanding this
document. Keep this manual readily available so that you can reference it as needed.

1.1 What Is the Purpose of this Operating Manual?

This operating manual serves as an aid for the installation and operation of the product and
supports the technical staff with all operating and maintenance tasks to be performed.
Furthermore, this manual is aimed at preventing dangers to life and health of the user and third
parties.

1.2 Who Is this Operating Manual Targeted To?

The operating manual provides a code of conduct for personnel tasked with the setup, operation,
maintenance, and repair of gas engines. A certain level of technical knowledge with respect to the
operation of gas engines and basic knowledge of electronic ignition systems are necessary.
Persons who are only authorized to operate the gas engine shall be trained by the operating
company and shall be expressly instructed concerning potential hazards.

1.3 Which Symbols Are Used in the Operating Manual?

The following symbols are used in this manual and must be observed:

Example

This symbol indicates examples, which point out necessary action steps
and techniques. In addition, you receive additional information from the
examples, which will increase your knowledge.

EXAMPLE

Notice

. This symbol indicates important notices for the user. Follow these. In

1 addition, this symbol is used for overviews that give you a summary of the
necessary work steps.

NOTICE

Warning

This symbol indicates warnings for possible risks of property damage or
risks to health. Read these warning notices carefully and take the
mentioned precautionary measures.

Rev. 01/2026 7



1 General Information

Danger

This symbol indicates warnings for danger to life, especially due to high
voltage. Read these warning notices carefully and take the mentioned

precautionary measures.

DANGER

1.4 Which Abbreviations/Acronyms Are Used in the Operating Manual?

In the operating manual or the user interface, the following abbreviations/acronyms are used.

Abb.
ADV

ASO

ATDC

BTDC

CAN bus

CE

CPU

°crankshaft

CSA

DC
DetCon

EMI

Term Description

Advance Advanced with
respect to top dead
center

Auxiliary

Synchronization

Output

After Top Dead Center
Before Top Dead

Center

Controller Area Bus for control
Network bus devices/networks
Conformité Conformity with EU
Européenne legislation

Central Processing
Unit

Degree crankshaft

Canadian Standards
Association

Direct Current

Detonation Control
System

Electromagnetic
Interference

Explanation
Indicates the direction for timing

Output for synchronizing the
MIC3+ and other controllers

Asynchronous serial connection
system for linking control units

Marking based on EU legislation
for certain products in conjunction
with product safety

Unit for the rotation angle of the
crankshaft

Organization that defines
standards, inspects products for
safety compliance, and issues
pertinent certifications.

Serves to prevent serious engine
damage caused by knocking
combustion.
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1 General Information

Abb. Term

EMC Electromagnetic
Compatibility

GPI General Purpose Input

GPO General Purpose
Output

HV High voltage

ISO International
Organization for
Standardization

LED Light Emitting Diode

MIC MOTORTECH Ignition
Controller

MICT MOTORTECH
Integrated
Configuration Tool

MOSFET Metal Oxide
Semiconductor Field-
Effect Transistor

PG Panzergewinde

POT Potentiometer

PWR Power

RET Retard

RS485/ Recommended

TIA485 Standard 485/
Telecommunications
Industry Association
485

TDC Top Dead Center

usSB Universal Serial Bus

Rev. 01/2026

Description

Multi-purpose input

Multi-purpose
output

Panzer Screw
Thread

Output/current

Retarded with
respect to the top
dead center

Explanation

Compatibility of electrical or
electronic equipment items with
their environment

Light emitting electronic
semiconductor

Software for the configuration of
the MIC3+

Semiconductor component

Screw thread type for cable screw
connections

Continuously adjustable potential
divider

Indicates the direction for timing

Industrial standard for a physical
interface for asynchronous serial
data transfer

Serial connection system to link a
computer to external devices



2 Safety Instructions

2.1 General Safety Instructions
The following safety instructions must be followed in the area in which the device is operated:

High voltage! Danger to life!

While the engine is running, there is danger to life through high voltage
particularly in the area of the ignition system. The following parts should
therefore not be touched or removed unless explicitly stated otherwise:

DANGER

Ignition coils and caps
— Wires of the high voltage circuit
— In- and output wiring of the ignition controller
— Pickups and their wiring

Danger to persons with implanted cardiac devices!

Electromagnetic impulses in the wiring of the ignition system may exceed
the permissible limits of active implanted cardiac devices such as
pacemakers or defibrillators. Persons with cardiac devices must
DANGER therefore not be present in the vicinity of the ignition system being
operated. Mark the operating location of the ignition system with the
corresponding standardized warning symbol.

MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to
operate. Nevertheless, the equipment can cause risks or damage can occur if the following
instructions are not complied with:

The gas engine must only be operated by trained and authorized personnel.

Observe all safety instructions of the system and all safety instructions of the system
operator.

Operate the equipment only within the parameters specified in the technical data.
Use the equipment correctly and for its intended use only.
Never apply force.

For all work such as installation, conversion, adaptation, maintenance, and repair, all
equipment must be disconnected from the mains and secured against unintentional
reactivation.

Perform only such maintenance and repair work as is described in the operating manual, and
follow the instructions given while working.

Only use spare parts supplied by MOTORTECH for the maintenance of the equipment.

Further work must only be performed by personnel authorized by MOTORTECH. Non-
compliance will void any guarantee for the proper functioning of the equipment as well as the
responsibility for the validity of the certifications.

Safety devices must not be dismounted or disabled.

Avoid all activities that can impair the function of the equipment.

Rev. 01/2026



2 Safety Instructions

— Operate the equipment only while it is in proper condition.
— Investigate all changes detected while operating the gas engine or ignition system.

— Ensure compliance with all laws, directives, and regulations applicable to the operation of
your system, including such not expressly stated herein.

— If the gas-carrying parts of the system are not entirely sealed, gas may escape and result in
explosion hazard. The inhalation of gas can also lead to death or severe health damage.
Therefore, upon completion of all assembly works, always check the system's tightness.

— Always ensure adequate ventilation of the engine compartment.
— Ensure a safe position at the gas engine.

— Thereis arisk of burning on hot surfaces. Allow the gas engine to cool down before starting
any work.

— Personal protective equipment (PPE), e.g. safety shoes and gloves, must be worn during all
work on the gas engine.

— Noise from the system can cause permanent or temporary damage to your hearing. Wear
suitable hearing protection at the system.

— Your behavior can reduce possible residual risks to a minimum. Observe responsible handling
of the gas engine and the gas-carrying system.

2.2 Electrostatic Discharge Hazards

Electronic equipment is sensitive to static electricity. To protect these components from damage
caused by static electricity, special precautions must be taken to minimize or prevent
electrostatic discharge.

Observe these safety precautions while you work with the equipment or in its vicinity.

— Before performing maintenance or repair work, ensure that the static electricity inherent to
your body is discharged.

— Do not wear clothing made from synthetic materials to prevent static electricity from building
up on your body. Your clothing should therefore be made of cotton or cotton blend materials.

— Keep plastics such as vinyl and Styrofoam materials as far away from the equipment and the
work environment as possible.

— Do not remove the circuit boards from the housing of the equipment.

2.3 Information on Electric Isolation
If ground and earth potential are not properly isolated, the following problems as well as others
can occur:

— Electromagnetic interferences (e.g. ground loops)

— Signal corruption (e.g. of the analog voltage signal)

— Unwanted leakage currents

In the entire electrical system, the earth potential and the negative pole of the power supply
should therefore be connected separately from each other for all devices where this is possible. If

possible, the negative pole of the power supply should only be connected to earth potential at one
point in the entire system.

Rev. 01/2026 n



2 Safety Instructions

Wiring Example
Device with Device with
shielded wires protection class Il

sl LE

ny
”§

L+

24VDC

Occurrence of ground loops

i The devices shown in the following image do not offer the option of

connecting the earth potential and the negative pole of the power supply
separately from each other. This results in a ground loop.

NOTICE

A ground loop is a closed loop connection in electrical cabling or wiring
that causes an unwanted voltage drop in the signal path due to the
impedance (resistance R > 0) of the loop when low-frequency
interference currents (l) are present.

Device 1 Device 2

(D Ol
1

|
I____+ _________________ -

Ground loop
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2 Safety Instructions

2.4 Special Safety Instructions for the Device

DANGER

Rev. 01/2026

Danger to life! Hazardous residual voltage!

After stopping the ignition, there is dangerous residual voltage for up to
three minutes in the ignition system. Do not touch any components of the
ignition kit during this time.

Explosion hazard!

If the system is located in a potentially explosive atmosphere, never open
the device (e.g. by opening the service screw or removing covers). There
is arisk of explosion.

Explosion hazard!

The replacement of parts or assemblies can impair compliance with CSA
Class I, Division 2 (Group C, D), T4.

Explosion hazard!

Do not disconnect any connectors while the system is live. If the system
is located in a hazardous area, there is a risk of explosion.

Explosion hazard!

Never remove the equipment while the unit is connected to a power
source. If the system is located in a hazardous area, there is a risk of
explosion.



2 Safety Instructions

Explosion hazard!
Do not remove or replace the fuse while the equipment is live.

Risk of burning!

The surfaces of the system may heat up to high temperatures.

Operational safety!

All connector screws and screw joints must be adequately tightened.

Operational safety!

The proper functioning of the device is only guaranteed if the device is
operated within the permissible supply voltage range. Therefore, use a
power supply in accordance with the specifications in the operating
manual.

Risk of destruction!

Magnetic fields and heat occur when welding, which may damage or
destroy the MIC3+. Therefore, pay attention to the following when
welding:

— Disconnect all electrical connections to the MIC3+ prior to welding.

— Protect the MIC3+ against direct contact with the welding unit and
magnetic fields, sparks and liquid metal.

Rev. 01/2026



2 Safety Instructions

Danger of interference with radio reception!

The device is not intended for use in residential areas and cannot ensure
adequate protection of radio reception in such environments.

2.5 CSA-Relevant Safety Instructions

English warning notice

WARNING - EXPLOSION
HAZARD - Substitution of
components may impair
suitability for Class |,
Division 2.

WARNING — EXPLOSION
HAZARD! Do not
disconnect while circuit is
live unless area is known
to be non-hazardous.

2.6 Proper Disposal

French warning notice

AVERTISSEMENT - RISQUE
D'EXPLOSION - La substitution
de composants peut rendre ce
materiel inacceptable pour les
emplacements de Classe |,
Division 2.

AVERTISSEMENT - RISQUE
D'EXPLOSION! Ne pas
débrancher tant que le circuit est
sous tension, a moins qu'il ne
s'agisse d'un emplacement non
dangereux.

German translation

WARNUNG - EXPLOSIONS-
GEFAHR! — Der Austausch von
Bauteilen oder Baugruppen
kann die Eignung fur die CSA-
Class I, Division 2 beeintrach-
tigen.

WARNUNG - EXPLOSIONS-
GEFAHR! Keine Verbindungen
I6sen, solange der Stromkreis
aktiv ist, auBer das Umfeld wird
als nicht explosionsgeféhrdet
eingestuft.

For the proper disposal of MOTORTECH equipment, observe the information provided at

www.motortech.de.
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3 Intended Use

3.1 Functional Description
The devices of the MIC3+ series are microprocessor controlled ignition systems, each consisting
of a board with a 32 bit main processor (CPU).

Please note that the manufacturer is not required to implement configurations of the ignition
controller for specific engines, and that devices may be delivered without pertinent configuration.
The ignition controllers of the MIC3+ series use information supplied by the pickups to precisely
determine the correct timing for the respective outputs. The ignition timing is influenced by
various inputs. This can be implemented using analog input signals, a speed characteristic, or
using a serial interface (USB, CAN bus, RS485). The devices can also be equipped with an optional
potentiometer for ignition timing adjustment.

During operation, the ignition controllers continuously monitor the system status of all installed
pickups and the correct operation of the primary ignition circuit by checking the information
received.

Depending on the severity of an error that is detected, the device will shut down immediately or
warn the operator. A corresponding message can be viewed on a connected computer.

To protect the engine, the ignition controllers additionally have an adjustable overspeed shut-off.

3.2 Applications

Danger of interference with radio reception!

The device is not intended for use in residential areas and cannot ensure
adequate protection of radio reception in such environments.

The ignition controllers of the MIC3+ series are designed for specific 2- or 4-stroke gas engines.
From 1to max. 12 ignition outputs are available.The ignition controllers supply the energy required
for the corresponding ignition coils of the gas engines and can supply signals for peripheral
equipment.

As per EN 55011, the MIC3+ ignition controller are equipment of Group 1and Class A.

Any use other than the one described in the operating manual shall be considered improper use
and will result in the voiding of any guarantee.
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4 Product Description

4.1 Technical Data

4.1.1 Certifications

The ignition controllers of the MIC3+ series are certified as follows: CE, CSA

The EU Declaration of Conformity and the CSA certificate of your MIC3+ can be obtained on
request from your MOTORTECH contact person (see section Customer Service Information on

page 150).

4.1.2 Mechanical Data

The MIC3+ has the following mechanical characteristics.

Feature

Dimensions

Weight

Shape of device

Mechanical environmental
conditions

Climatic environmental conditions

Rev. 01/2026

Value

Light Duty Version:
251 mm x 240 mm x 90.99 mm (9.90" x 9.45" x 3.58")
(length x width x height)

Heavy Duty Version:
251 mm x 240 mm x 107.5 mm (9.90" x 9.45" x 4.23")
(length x width x height)

Light Duty Version:
3.1kg (6.8 Ibs)

Heavy Duty Version:
3.8 kg (8.4 Ibs)

See chapter Overview Drawings on page 22

The housing is resistant to general atmospheric
contaminations.

Resistant to gas engine lubricants.

Protection class: |
Protection: IP69

The specified protection class and type is only guaranteed if
all external cable connections are connected according to
the connector specification and the protective cap is firmly
attached to the USB connection.

Housing surface temperature:

Light Duty Version:

—-40 °C to +60 °C

(—40 °F to +140 °F)

Heavy Duty Version:

-40°Cto+70°C

(—40 °F to +158 °F)

Max. 85 % humidity without condensation up to 3,000 m
(9,842') above sea level



4 Product Description

4.1.3 Warning Notices on the Device

Validity of warning notices on device
[ ]

1 components connected to it.

NOTICE

English warning notice on French warning notice on the
the device device

WARNING! Read and ATTENTION! Lisez et comprenez
understand the installation le manuel d’installation et

and operating manual prior d’utilisation avant d’installer ou
to installing or making any  d’effectuer une modification.
adjustments.

WARNING - EXPLOSION AVERTISSEMENT - RISQUE
HAZARD! Do not D'EXPLOSION! Ne pas
disconnect while circuitis  débrancher tant que le circuit est
live unless area is known sous tension, a moins qu'il ne
to be non-hazardous. For s'agisse d'un emplacement non
wiring details refer to dangereux. Pour plus de détails
operating manual. de cablage, veuillez consulter le
manuel d’utilisation.

CAUTION! Do not pressure  ATTENTION! Ne pas laver cette

wash this device. Damage boite de contréle en utilisant un

to electronic components  jet sous pression. Cela pourrait

may result. endommager les composants
électroniques.

Warning Symbol on Device

Warning of hot surface

The warning notices on the device are valid for the MIC3+ and all

German translation

WARNUNG! Lesen und ver-
stehen Sie die Installations-
und Betriebsanleitung vor der
Installation und bevor Einstel-
lungen vorgenommen werden.

EXPLOSIONSGEFAHR! Keine
Verbindungen I6sen, solange
der Stromkreis aktiv ist, auBer
das Umfeld wird als nicht ex-
plosionsgefahrdet eingestuft.
Hinweise zur Verkabelung
finden Sie in der Betriebsan-
leitung.

ACHTUNG! Das Gerat nicht mit
Hochdruck reinigen. Es kdnnte
zu Schéden an den elektro-
nischen Bauteilen fihren.
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4 Product Description

4.1.4 Product Identification — Labeling on the Device
The necessary numbers for unique product identification are on the device:

— Part number of the ignition controller (P/N)

Arrangement number of the ignition controller (A/N)

— Serial number of the ignition controller (S/N)

= MOTORTECH

www.motortech.de

IP/N  66.00.350-12 |

|A/N  3C1.12.C0Q0-000-AA-3 |

IS/IN 012345678 |

4.1.5 Electrical Data

The MIC3+ has the following electrical characteristics.

Feature
Power consumption

Power supply

Required current

Number of outputs

Firing angle

Ignition frequency

Rev. 01/2026

Value
Max. 65 W at 24 V

Nominal voltage: 24 V DC
Operating voltage: 10 V DC to 32 V DC

Max. current 7.0 A. An estimation of the power requirements can be
found after this table.

6 or 12 outputs

The size of the firing angle depends on the max. overspeed. The
smallest ignition angle can be calculated using the following formula:

0 d [min ™!
Ignition Angle = %D[m\n] x360°x1.7ms

With full energy output (all 12 ignition outputs with 300 mJ), an
ignition frequency of 180 Hz as continuous load is possible. With less
ignition energy or in case of a brief overload, 200 Hz is possible. The
maximum output load of 60 W must not be exceeded.

2-stroke engine:
Overspeed [mim'1]

Ignition Fequency =Tx Number of Ignition Outputs

4-stroke engine:

" 1 Overspeed [min'1] »
Ignition Fequency = 3 X T x Number of Ignition Outputs



4 Product Description

Estimation of Current Requirements
These current values are based on a nominal speed of 1800 rom and 300 mJ energy.

Outputs Voltage Required current  Voltage Required current
6 24V 21A 12V 39A
12 24V 3.3A 12V 6.4 A

* Nominal voltage 24 V DC

Electrical Data for Inputs and Outputs
The inputs and outputs of the ignition controller have the following electrical data:

Inputs and outputs Values

Analog current input Current range: 0 mA to 20 mA (adjustable in MICT)
Input impedance: 27 Q || 1 yF

Analog voltage input Voltage range: 0 mA to 10 mA (adjustable in MICT)
Input impedance: 12.4 kQ || 200 nF

Auxiliary analog input supply 5V to 24 V/50 mA depending on the configuration in the MICT
voltage

Binary input (Start/Stop) Wiring

Input current: max. 20 mA
Ignition stop: 0 V to 0.8 V (low level)
Ignition release: 2.8 V to 32 V (high level)

Binary input (schedule A/B) Wiring

Input current: max. 20 mA
Schedule A: 0 Vto 0.8V (low level)
Schedule B: 2.8 V to 32 V (high level)

Binary input (GPI, general Wiring

purpose input) Input current: max. 20 mA

Low level: 0 Vto 0.8V
High level: 2.8 Vto 32V

(Function dependent on the configuration in MICT, see
Inputs/Outputs — Inputs on page 99)
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4 Product Description

Inputs and outputs
Go/NoGo and GPO outputs

LED
ASO output

Pickup input

Ignition coil outputs

Values

One GPO (General Purpose Output) and one Go/NoGo output
Implementation as optical MOSFET relay

Maximum switching voltage: 32 V DC

Peak/steady current: max. 100 mA DC

Output power: max. 2.5 W

Internal resistance: 58 Q to 60 Q

Activation delay: 0.5 ms / max. 100 mA load

Deactivation delay: 0.2 ms / max. 100 mA load

If a short is found at the output, a safety circuit, which makes
the output highly resistive, is found at the output, so that the
current sets itself at 50 mA to 60 mA.

Five LEDs are used as status indicators.

TTL level (5V)
max. current: £ 10 mA

Impedance: 10 kQ

The voltage supply for inductive pickups can be set using the
MICT from 5V to24 V.

Max. frequency for the pickups: 10 kHz

The formula for determining the frequency of the pickups can
be found in the note following this table.

For a pickup output impedance of 120 Q to 10 kQ, the pickups
connected to the MIC3+ may not have a higher voltage than
+40 V and the connected power may not exceed 1 W.

Output voltage: max. 250 V

Output energy in normal operation: max. 300 mJ (depending
on the ignition coils used)

Output energy in the start phase: max. 500 mJ

Frequency of the pickups
i The frequency of the pickup is calculated as per the following formula.
Overspeed min Number of Pickup E Revolti
NOTICE Frequency-T X Number of Pickup Events per Revolution

Rev. 01/2026
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4 Product Description

4.1.6 Interfaces
Depending on the device version, the following interfaces are available:

USB Interface
— Compatible with USB 1.1 and higher

— The connector type B is only suitable for temporary data exchange and not for a permanent
connection.

— Max. wire length 5 m (16.4")

CAN Bus Interface
— Classical Extended Frame Format (CAN 2.0B)

— As perISO 11898 standard, 50 kbit/s to 1 Mbit/s

— Protected against transients (automotive classification)

— Max. 110 participants

— Max. wire length 250 m (820') depending on the transfer rate

RS485 Interface
— According to TIA-485-A (03/2003)

— Max. 32 participants
— Max. data transfer rate 9.6 kbit/s to 115.2 kbit/s
— Max. wire length 100 m (328') depending on the transfer rate

Pay attention to the wiring diagrams

-4 Depending on the device version, certain signals or interfaces described
1 in these instructions may not be available. You are also always to pay
attention to the wiring diagrams enclosed with the input and output cable
NOTICE harnesses.

4.1.7 Requirements for External Equipment
External equipment shall fulfill the input and output specifications of the MIC3+.

4.1.8 Overview Drawings
The configuration of the connector varies depending on the device type. The connectors shown
correspond to the standard version.
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4 Product Description
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4 Product Description

Front View Heavy Duty Version

107,5 mm (4.23")

USB Port
A USB connection is located at the front of the device to connect the MIC3+ to a computer.

4.1.9 LED Functions

O Status
O Firing

(O Pickup 1
O Pickup 2
O apPoO
Labeling Function
Status Firmware version 1.11.00000 and higher:
LED flashes green if the device is running with no errors.
The LED flashes red if an error has occurred.
For details, refer to the following overview.
Older firmware versions:
LED flashes green if the device is running with no errors.
The LED flashes red if an error has occurred.
The LED flashes yellow if a warning has occurred.
The firmware version of your device can be found in the MICT in the
window Runtime Data — Information. Refer to the section Runtime Data
— Information on page 127.
Firing LED lights up when the ignition is active (exception: during the self test).
Pickup 1and 2 LEDs flash when the pickups are active.
GPO LED is on when the GPO is activated.
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4 Product Description

Indication via the Status LED (from Firmware Version 1.11.00000 and Higher)

The flashing sequences shown below are repeated until the device has left the respective state
again. However, the flashing sequences are always executed to the end and are not interrupted
accordingly.

The status LED flashes green:

Waiting for sufficient supply voltage
Fast flashing green/off 100 ms

Synchronization/firing active
Flashing one time green 250 ms on, 750 ms off

Ready for operation
slow flashing green/off 500 ms

Bootloader — connection to computer started/update mode
Flashing one time green 2,000 ms on, 250 ms off

Firing locked
3 flashes green/off 250 ms, 750 ms off

Configuration/wait for 0 RPM
6 flashes green/off 250 ms, 750 ms off

The status LED flashes red:

Critical error/assertion
fast flashing red/off 100 ms

Operational error — general/system error
slow flashing red/off 500 ms

Bootloader - faulty firmware
Flashing one time red 2,000 ms on, 250 ms off
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4 Product Description

Operational error — pickup
2 flashes red/off 250 ms, 750 ms off

Operational error — overspeed
4 flashes red/off 250 ms, 750 ms off

Operational error - insufficient supply voltage
5 flashes red/off 250 ms, 750 ms off

The status LED flashes orange:

26

Selftest
Flashing one time orange 250 ms on, 750 ms off
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5 Installation Instruction

5.1 Unpacking

Unpack the equipment, taking care not to damage it. Always place the device safely and protected
from falling over or falling down. Ensure that the operating manual is always stored with the
ignition controller and is easily accessible. Check the contents for completeness and verify that
the device type meets your application requirements.

Scope of Supply
The scope of supply of the MIC3+ ignition controller consists of the following components:

— Ignition controller of the MIC3+ series

— Installation set incl. four vibration dampers

— Ground strap

— Three multiple sealing inserts and five sealing plugs for PG screw joints
— Storage device with configuration software MICT and operating manual
— Safety instructions for the MIC3+

— USB interface cable for connecting the ignition controller to a computer

5.2 Installation of the Ignition Controller

The installation of the MIC3+ ignition controller is implemented on a fixed bracket e. g. on a wall
near the engine. Use the included rubber vibration dampers and the ground strap. The installation
location of the controller must be selected so that the distance to the pickups installed on the
engine ensures a reliable signal transmission to the ignition controller, and so that there is
adequate space for maintenance and repair work. The mechanical specifications must always be
complied with (refer to Mechanical Data on page 17). The ground strap serves to ground the
ignition controller and must be used accordingly. Ensure a flawless electrical connection for this
purpose.

Installation locations where strong vibrations or extreme ambient temperatures are present are
not permissible and result in the guarantee being voided. The permissible temperature range is:

—40 °C (-40 °F) to +60 °C (+140 °F)

Risk of destruction!

The device must not be installed directly on or at the engine, as vibration
and heat may cause damage to electronic components. This also applies
if vibration dampers are used.
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5 Installation Instruction

5.2.1 Installation of the Vibration Dampers
There are two options for using the vibration dampers from the MIC3+'s scope of supply. The hole
patterns can be found in section Overview Drawings on page 22.

Option A

screws M8x16 , four rim lock washers
M8 Bl and four washers M8 El.

2. Fasten the MIC3+ to the vibration dampers.
Use four washers M8 Bl and four lock nuts
VE

» Fasten the ground strap to the ground
pin (see Installation of the Ground Strap
on page 29).

W 27 Nm /19 oot 1. Fasten th.e four v!bratlon r.jampers H to the
selected installation location. Use four
T

L

A 27 Nm /19 Ib-ft

ot
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5 Installation Instruction

Option B
1. Fasten the four vibration dampers H o the
8 27 Nm /19 Ib-ft MIC3+. Use four screws M8x16 B, four rim
lock washers M8 Bl and four washers M8 .
2. Fasten the MIC3+ to the selected installation
location using the vibration dampers. Use

mvs .

» Fasten the ground strap to the ground
pin (see Installation of the Ground Strap
on page 29).

$ four washers M8 il and four lock nuts
T

—=

= [
@ 27 Nm /19 Ib-ft

5.2.2 Installation of the Ground Strap

1. Fasten the ground strap H to the MIC3+
E ground pin. To do so, use one washer M6 H,
one tooth lock washer A6 Ell and one poly
- lock nut M6 .
2

/8 11Nm / 8 |b-

=4

o] o]

Connect the ground strap to one of the sides
suitable for grounding.

|

> You can wire the ignition controller as
described in section Wiring of the
Device on page 31.

(schematic representation)
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5 Installation Instruction

5.3 Determine the Installation Location of the Pickup

Set the positions of the pickups depending on engine type and application. All angle reference
information is based on:

TDC 1st cylinder / compression cycle

The installation location for the pickups must have adequate mechanical strength and must not
exceed the specified temperature ranges. The pickups are designed for the appropriate use only,
multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate the
calibration of the sensor. Comply with the pertinent regulations for the wire routing.

For the exact positioning of the individual pickups, refer to the examples given in the drawings
(see section Input Wiring — Pickups on page 35).

30 Rev. 01/2026



6 Wiring of the Device IOTORT=CH

6.1 Input and Output Wiring on the Controller

Operational safety!
All connector screws and screw joints must be adequately tightened.

Assignment of the wire colors

. Take the assignment of the wire colors of the wiring harness for the input
1 and output wiring from the wiring diagram enclosed with the wiring
harness.

NOTICE

Pay attention to the wiring diagrams

) Depending on the device version, certain signals or interfaces described

in these instructions may not be available. You are also always to pay
attention to the wiring diagrams enclosed with the input and output cable

|

NOTICE harnesses.
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6 Wiring of the Device

6.1.1 Input Wiring

Input Connector

-7 A

LI

«C oD E oF G
oHod KL MN

P aR WS T UV W

35-pole input connector (outside view)

Power
Signal
GND
Shield
Power
Signal
GND
Shield
Hi
Com
Lo
Shield

Pin Assignment
A L+(24V)

B L — (negative pole)
C Pickup 1

D

E

F

G Pickup 2

H

J

K

L CAN

M

N

=]

R Go/NoGo +
S Go/NoGo -
T GPO +

u GPO -

32

Pin

\
w
X
Y
z
a
b

0 Q O

(e}

Assignment

ASO +

ASO -

ASO Shield

RS485 TX +
TX -

RX +
RX -
Analog GND
Analog Power
Timing | in —
Timing lin+
Analog Shield
Start/Stop +
Schedule A/B +
GPI1 +

Binary Com
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6 Wiring of the Device

6.1.2 Input Wiring — Power Supply

|

NOTICE

Rev. 01/2026

Operational safety!

The proper functioning of the device is only guaranteed if the device is
operated within the permissible supply voltage range. Therefore, use a
power supply in accordance with the specifications in the operating
manual.

Design of power supply

For the power supply, an overcurrent protection mechanism must be set
up with a circuit breaker (16 A DC with tripping characteristic B), which
allows switching off. When selecting the circuit breaker, the conditions of
the installation site and the ambient temperature must be considered. The
circuit breaker must be easy for the user to access and marked as a
disconnecting device for the ignition controller.

If the power is supplied via a power supply unit, the following
specifications must be observed additionally:

— Voltage: 24 V DC; Current: at least 25 A
— Wiring: at least 1.5 mm?2 cross-section
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6 Wiring of the Device

L 224V DC (nominal voltage)

L+ L-

34

Variations
1 Battery Generator Control unit
2 Power supply
+ —0
~
3 Battery Charger
= p—0
s
0
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6 Wiring of the Device

6.1.3 Input Wiring — Pickups

Example Configuration (one Active, one Passive Pickup)

Camshaft

T}

Crankshaft

Signal @
ano ()

Shield
Shield

_Power @
el ()
aND ()

-Power @

Pickup 1 Pickup 2

The recommended distance to the triggering is 0.75 mm to 1 mm (0.03" to 0.04") for MOTORTECH
pickups. Please note that additional fine-tuning is required for every pickup position due to the
different conditions of the engines.

One revolution of the pickup changes the distance as follows:

Thread Change in distance

M12x1 1revolution 2 1 mm (0.04")
5/8"-18 UNF 1revolution 2 1.41 mm (0.05")
3/4"-16 UNF 1 revolution 2 1.59 mm (0.06")
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6 Wiring of the Device

Allocation of the Wire Colors (Example Configuration)

Camshaft
Pin Designation Wire color
C Pickup 1 Power Brown
D Pickup 1 Signal black
E Pickup 1 GND Blue
F Pickup 1 Shield Shield
Crankshaft
Pin Designation Wire color
Pickup 2 Signal White
Pickup 2 GND Brown
K Pickup 2 Shield Shield

For problems with the pickup signals, refer to the section Pickup Input Errors on page 149.

1

NOTICE

|

NOTICE

36

Adjusting the pickup sensitivity

Depending on the type of impulse source (interference), it may be
necessary to increase the pickup sensitivity to ensure that the resultant
signal strength is sufficient for reliable operation. You can make these
adjustments in the MICT. Refer to the section Engine — Pickups on
page 86.

Auxiliary pickup supply voltage

An auxiliary supply voltage for active pickups can be configured using the
MICT. The voltage can be set in the range from 5 V to 24 V and is supplied
at the connections Pickup 1 Power to Pickup 2 Power. Refer to the section
Engine — Pickups on page 86.
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6 Wiring of the Device

6.1.4 Input Wiring — Timing and Safety Devices

Example Configuration

Timing | in - @
Timing | in + @

Analog Shield

Analog GND @
Analog Power @

Start/Stop + @

Schedule A/IB +

GPI +
Binary Com

Two-Wire Transmitter

Rev. 01/2026

Analog Power

Timing lin +
Timing lin—

Analog GND
Analog Shield

* See subsequent drawings for details

x = bridge for permanent authorization

Switch Start/Stop

open Ignition — OFF
closed Ignition — ON
Switch A/B

open Schedule A
closed Schedule B

Four-Wire Transmitter

A Analog Power

+V
+1 Timing | in +

-1 Timing lin -
-V \VA Analog Shield




6 Wiring of the Device

1

NOTICE

EXAMPLE

38

Auxiliary supply voltage for the analog inputs

An auxiliary supply voltage for the analog inputs can be configured using
the MICT. The voltage can be set in the range of 5 to 24 V and is made
available on the connection Analog Power. Refer to the section Timing —
Analog Inputs on page 90.

Wiring MIC3+ ignition controller and DetCon detonation control system

The following diagram shows an example of the wiring of an MIC3+
ignition controller with a DetCon detonation control system in cases
where the analog current signal (4-20 mA) at the output / out is to be used
for the ignition timing adjustment.

g g o+
%“ 5 Ti ; MIC3+-
§ § E E ignition
A controller
0]0]0
DetCon
[OOOOOOOOOOOO' detonation
control system
453 8 §e.255
-

Furthermore, the limits of the analog current input will need to be set at
4 mA to 20 mA and the auxiliary supply voltage of the analog inputs to
24V in the MICT. Refer to the section Timing — Analog Inputs on page 90.

The timing is transmitted by MIC3+ via the auxiliary synchronization
output (ASO) to the DetCon, and will need to be wired and configured
accordingly. Refer to the section Output Wiring — Binary Outputs
(Go/NoGo, GPO, ASO) on page 39.
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6 Wiring of the Device AIOTORT=CH

General purpose input GPI

) The general purpose input GPI can be assigned various functions via the
1 configuration. Refer to the section Inputs/Outputs — Inputs on page 99.
NOTICE

6.1.5 Output Wiring — Binary Outputs (Go/NoGo, GPO, ASO)

Example Configuration

oL+
K1 --
*) DetCon or other external device (for wiring
K2 I'" of the DetCon, see following example)
K1=Go/NoGo relay
K2 = GPO relay
) L&7VDCto32VDC
o L-

GPot + (3}

GPO1-

asot + ()
Asol- ()

Shield

Go/NoGo + @

Go/NoGo -
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6 Wiring of the Device

o +
l Qut +
A1 | Qut-
$ E _ﬁ Relay Al I
A2 Eﬁ
$ 'ﬁ Relay
Out + A2
TOut -
ol - o| —

(L27VDCto32VDC)

DetCon connection

on connector Synchronization.

EXAMPLE

DetCon

Synchronization

<< o
= =

asot + (<)
Aso1 - (2)

Shield

Connect the ASO output on the DetCon to the connections in A and in B
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6 Wiring of the Device

6.1.6 Wiring — PowerView3, PowerView4
Connect a PowerView3 or PowerView4 HMI module to the MIC3+ as follows.

CAN Connection between Ignition Controller and the PowerView

If the PowerView is to be connected exclusively to the MIC3+ ignition controller via CAN, you can
connect it directly to the MIC3+ using the CAN cable supplied with the PowerView, as shown in
the following illustration. To do so, you need to insert the connector in the CAN interface on the
PowerView. On the MIC3+, connect the wires of the CAN cable to the corresponding CAN
interface connections. The assignment of the wires can be found in the wiring diagram enclosed
with the CAN cable or in the PowerView operating manual.

ke
= % o = % 3 Connector for CAN interface on the PowerView
ale& 3 £ & &
Ll [
— CAN cable
4] »

CAN interface on the ignition controller

CANHi @
N Com @

CAl

* To avoid ground loops, connect the shield on one side.

canLo (Z)
canstil (T)

L~

120Q

Power Supply of the PowerView via the Ignition Controller

If you use a MOTORTECH ignition controller with a service cover and connector strip and do not
supply any other devices with power via the PowerView, you have the option of supplying power
to the PowerView via the ignition controller using the power supply cable provided with the
PowerView. For this purpose, a special connector is included in the PowerView's scope of supply.
The connector for the voltage supply of the ignition controller must be replaced by this one.

Connector supplied with Connector supplied with
the ignition controller: PowerView:
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6 Wiring of the Device

Proceed as follows:
1. Disconnect the power supply to the ignition controller and, if necessary, to the PowerView.
2. Remove the connector for the power supply from the ignition controller.

Negative terminal: Disconnect the conductor from contact &l and insert it into contact B of
the connector provided with the PowerView.

4. Positive terminal: Disconnect the conductor from contact E& and insert it into contact &8 of the
connector provided with the PowerView.

5. Plugthe wire L — (white) from the power supply cable provided with the PowerView into
contact . For plugging into the contact, use a wire end ferrule provided with the PowerView.

6. Plugthe wire L + (brown) from the power supply cable provided with the PowerView into
contact B4. For plugging into the contact, use a wire end ferrule provided with the PowerView.

7. Insert the connector provided with the PowerView into the power supply connection of the
ignition controller.

8. Insert the connector at the other end of the power supply cable from the PowerView's scope
of supply into the PowerView power supply connection.

9. Ensure that the power supply cables to the ignition controller and between the ignition
controller and the PowerView are correctly fused.

10. Connect the device's power supply.

» The power supply of the PowerView is now provided through the connector on the
ignition controller.
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6 Wiring of the Device

6.1.7 Output Wiring — CAN Bus Interface

1

NOTICE

Rev. 01/2026

CAN bus wiring

Note the following when connecting the CAN bus:

Each bus end must be fitted with a terminating resistor of 120 Q (see
drawing).

Only use cables that are specified by the manufacturer for use in the
CAN bus.

The shield must be connected across the entire bus cable.
The cable shielding must be connected to earth at a single point.

The reference potential (Com) of the CAN bus must be connected to
earth at precisely one point.

The maximum cable length depends on the bit rate:

Bit rate Maximum cable Maximum length Maximum length
length of a stub of all stubs

1 Mbit/s 25 m (82" 1.5 m (5") 7.5m (25"

800 kbit/s 50 m (164") 2.5m (8" 12.5m (41)

500 kbit/s 100 m (328") 5.5m (18" 27.5m (90")

250 kbit/s 250 m (820") 11 m (36') 55 m (180")

125 kbit/s 500 m (1,640 22 m (72" 110 m (360")

50 kbit/s 1,000 m (3,280') 55 m (180" 275 m (902"

Comply with the standards ISO 11898-1 and CiA® 303-1.
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6 Wiring of the Device

The MIC3+ series ignition controllers are wired usinga MOTORTECH harness as standard. The
harness contains a 120 Q terminating resistor for the CAN bus. The devices must therefore be
used at the bus end.

First device Second-to-last device
= E x 5 E 2
£ 8 3 £33
CAN Bus
553 : (( :
2 8 3 R=120Q \\ R=120 Q

cAn Com (Z)
CANLo (Z)

T =
z 3 5 E B 5 E &
= 5 T o - T o -
© =
T
S
Second device Last device

CANopen® protocol

If you require information on the CANopen® protocol of your MIC3+,

1 contact your MOTORTECH contact person (see section Customer Service
Information on page 150).

NOTICE
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6 Wiring of the Device

6.1.8 Output Wiring — RS485 Interface
The RS485 interface can be wired as two-wire or four-wire wiring and twisted cables must be
used. With both variants the load resistance (Rr=120 Q) is the characteristic impedance of the

cable.

Two-Wire Wiring

First device

RX +
RX —

M=
TX +

Four-Wire Wiring

((

Second device

A\
))

Second-to-last device

First device
(Master)
RX + 4
I D
RX -
TX - AN
. )) 2
TX+ 7 /
+ 1 1 - + 1 1 +
E EE F E EEE
Second device Second-to-last device
(Slave) (Slave)
Rev. 01/2026

Last device

RX+
RX -

Ti=
X+

Last device
(Slave)

TX+

TX-
RX -

RX +
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6 Wiring of the Device

Connection on the Ignition Controller

46

1

NOTICE

RS485
+ 1 (= + 1
= E 38 B B
+ [ £+ 1
Q
EE 8 2 B
w w w0 w w
I ¥ T R 2
N D D o »
o o o o o

Wiring of the RS485 interface
Follow these instructions for the RS485 interface wiring:

Max. 32 devices can be connected to a bus.

The maximum wire length is 100 m (328') depending on the transfer
rate.

Each bus end must be fitted with a terminating resistor with 120 Q in
each pair of leads (as indicated in the drawing).
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6 Wiring of the Device

6.2 Ignition Coil Wiring

1

NOTICE

|

NOTICE

|

NOTICE

Protection when using wiring rails

Every wiring rail on the engine block should be grounded to avoid
disruptions in the device caused by secondary current in the ignition
coils.

Ignition coil wiring

In the MICT there are two types of wiring with predefined output
configuration supported in the engine database for many engines:

— Wired in straight order

— Wired in firing order

For information on straight order wiring refer to Straight Order Wiring of
the Ignition Outputs on page 48 and Engine — Parameters on page 78.

For wiring in firing order, the first cylinder in the firing order is connected
to the Al output, the second to A2, etc.

If a different wiring was implemented, the output configuration in the
MICT must be adapted accordingly. Please note that the wiring cannot be
checked by the software (see section Engine — Parameters on page 78).

Conductor cross-section for primary wiring

If you do not use a harness manufactured by MOTORTECH, the primary
wiring must have a conductor cross-section of 1.5 mm?2.

17-pole connector (outside view)

Rev. 01/2026
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6 Wiring of the Device

The table shows the pole assignments for the standard 6 and 12 cylinders versions of the MIC3+.

el
o
o

=Sl »wl v Z I r X« T O Mmoo o >

12 outputs
Output A1l
Output A2
Output A3
Output A4
Output A5
Output A6
Output A7
Output A8
Output A9
Output A10
Output A1
Output A12
Not assigned
Not assigned
Not assigned
Not assigned

Ground

6 outputs
Output A1
Output A2
Output A3
Output A4
Output A5
Output A6
Not assigned
Not assigned
Not assigned
Not assigned
Not assigned
Not assigned
Not assigned
Not assigned
Not assigned
Not assigned

Ground

6.3 Straight Order Wiring of the Ignition Outputs

Risk of damage to engine

If you use MOTORTECH wiring rails for straight order wiring, it is
absolutely necessary that they are correctly selected and installed for the
respective engine. Even a rotated installation can cause serious damage

to the engine, for example.

Straight order wiring, along with wiring in firing order, is supported by the MICT for many engines
with predefined output configurations in the engine database. That means that if the wiring is
carried out accordingly and the option Wired in Straight Order is selected in the MICT, no other

adaptation of the output configuration is necessary.

48
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6 Wiring of the Device

You can use straight order wiring, if:

— Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing
order needs to be configured directly in the ignition controller. The ignition coils on the wiring
rail are identified with Connector Pin 1to Connector Pin X.

— Make the wiring of the ignition controller corresponding to the instructions in the following
sections (for example with an open wiring harness or via a junction box).

The execution of straight order wiring is dependent on the type of engine (in-line or V-engine).

Version with 6 Outputs

Pole 6 outputs In-line engine V-engine
Connector*  Coil** Connector*  Coil**

A Output A1 1 1 1 1

B Output A2 1 2 2 1

C Output A3 1 3 1 2

D Output A4 1 4 2 2

E Output A5 1 5 1 3

F Output A6 1 6 2 3

G -

H _

J —

K —

L —

M -

N -

P _

R -

S -

T Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail
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6 Wiring of the Device

Version with 12 outputs

Pole 12 outputs In-line engine V-engine
Connector*  Coil** Connector*  Coil**
A Output Al 1 1 1 1
B Output A2 1 2 2 1
C Output A3 1 3 1 2
D Output A4 1 4 2 2
E Output A5 1 5 1 3
F Output A6 1 6 2 3
G Output A7 1 7 1 4
H Output A8 1 8 2 4
J Output A9 1 9 1 5
K Output A10 1 10 2 5
L Output ATl 1 1 1 6
M Output A12 1 12 2 6
N —
P —
R -
S -
T Ground

Connector* = connector on the wiring rail
Coil** = ignition coil with the corresponding number on the wiring rail

50
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7 Functions

The ignition controllers of the MIC3+ series include freely configurable safety and auxiliary
functions that, amongst others, can shut down the engine in case of fault.

Angle indications in the operating manual

-4 All angles in this operating manual are given in °crankshaft. Exceptions
1 are clearly identified.
NOTICE

7.1 Pickup Sensitivity

To increase the signal interference distance, the sensitivity of the pickup signal inputs can be
changed for suitable pickup signals. This setting can be implemented individually for each input.
For this purpose, a pre-trigger voltage can be set below which signals are interpreted as
interference and are therefore not analyzed. A pre-trigger voltage set to a high level will thus
result in a low pickup sensitivity level.

You can enter the settings for the pickup sensitivity with the MICT. Refer to the section Engine —
Pickups on page 86.

7.2 Monitoring of Pickup Signals

The MIC3+ monitors the pickup signals. Any other errors are displayed in the MICT. For more
information on the errors, please refer to the overview in the section entitled Pickup Input Errors
on page 149.

7.3 Go/NoGo

The binary output (Go/NoGo) is a potential-free output. It is closed during firing and opens when
the ignition switches off. The max. switching current is 100 mA. The output can drive an external
relay that e.g. opens a gas valve.

The following errors can cause the ignition outputs to shut down:
— Overspeed

— Pickup error

— Error HV power supply

— Failure of the output monitoring

— Overload/temperature shut-down

- Alarms

— Insufficient supply voltage (Low Power)
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7 Functions

Use master control
. The outputs of the MIC3+ are not SIL compliant. Therefore, always use an
1 additional master control for safety-critical applications.
NOTICE

7.4 Ignition Timing Adjustment

The ignition controller has several functions for the timing correction.

Influences on ignition timing

e Be aware that the actual timing of the engine can also be influenced by

1 external signals (e.g., analog current or voltage input).

NOTICE

Operational safety!

The MIC3+ ignition controller must first be correctly configured for the
engine being used before you can start the engine.

An incorrect configuration can result in damage to the engine.

The figure below gives you an overview of the different functions of the timing correction, which
will be explained in more detail in the subsequent sections. Functions that can be
activated/disabled via the MICT are marked by a switch symbol. Depending on the device version,
some functions might not be available.
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7 Functions

Per schedule:

| Base Timing

| Speed Curve I—/_p®
[Analog Voltage Input |—/—P
| Analog Current Input I—/—>
[ Potentiometer I_/_>

Global:

| Ignition Timing Correction I—}@
Per cylinder:
Cylinder Individual — | Limited by the B @
Offset

min./max. cylinder
individual offset

Limited by the
min./max. Timing

7.4.1 Analog Inputs

The timing point control can be adjusted with a linear current signal. This signal can be supplied,
for example, by a potentiometer, a pressure sensor for charging pressure, or a detonation
controller.

With the analog process signal (current loop signal) at the analog current input, the timing point
can be offset in the advanced or retarded direction within a defined range.

Similarly or additionally, the timing can also be influenced by an analog voltage signal at the
corresponding input.
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The levels of the analog inputs can be set in the range from 0 mA to20 mAand 0 Vto10 V. You
can make this configuration with the MICT. Refer to the section Timing — Analog Inputs on page
90.

At the voltage output (Analog Power), a configurable auxiliary voltage is supplied that can be used
for supplying power to external sensors.

Configuration examples

In this example the analog inputs are configured in the Timing — Analog
Inputs window as follows:

EXAMPLE Input current: 4 mA to 20 mA

— Input voltage: 0 Vto5V

Characteristic 4 mA to 20 mA /0 V to 5 V — Ignition timing adjustment
toward retarded.

BTDC

5>

40°4

. amA  ov o
30°1 Base Timing 30° BTDC

20§ 15° retarded ignition

20mA 5V
10°+

0° > ¢

Characteristic 4 mA to 20 mA / 0 V to 5 V - Ignition timing adjustment
toward advanced.

BTDC

r

40°+

20mA 5V L
30° 15° advanced ignition

20"y Base Timing 15° BTDC

oo 4mA OV

0° >t
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7.4.2 Cylinder-to-Cylinder Alignment
The cylinder-to-cylinder alignment enables the user to change the timing for individual cylinders
to optimize their combustion.

You can enter the settings for the cylinder-to-cylinder alignment with the MICT. Please refer to
the chapter Cylinder Individual Offsets on page 135.

Use of measuring unit

. Use this setup option only if a suitable measuring unit is available for

1 determining the optimum timing point, so that the result of a change can
be assessed immediately.
NOTICE

7.4.3 Speed Curve

To optimize the ignition, for example, during the start phase of the engine, a speed curve can be
defined for the MIC3+ ignition controllers. To create this curve, up to eight adjustable speed points
are available.

You can configure the speed curve with the MICT. Refer to the section Timing — Schedule A/B —
General on page 91.

7.4.4 Ignition Timing Correction

Via the ignition timing correction, the global ignition timing, limited by the timing limits of the
current schedule, can be adjusted. Refer to the section Runtime Adjustments — Timing on page
131.

7.5 Firing Angle
The min. distance between two ignition angles depends on the overspeed. The smallest ignition
spacing per output bank can be calculated using the following formula:

Overspeed [min”)

Ignition Angle = ———— x 360°x1.7ms
60

7.6 HV-Power Supply Error Monitoring
The voltage applied is monitored for excess voltage or low voltage by the integrated power
supply. For both errors a Power-Fail error is saved and the device shuts off.
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7.7 Output Monitoring

Electronic switches are used for the ignition outputs of the MIC3+ ignition controller If one of these
switches is defective, this would lead to a primary short or a primary open output. This can cause
problems when operating the engine or can damage the engine. The function of the outputs is
therefore monitored and errors that occur are displayed in the runtime data in the MICT or can be
transmitted via fieldbuses. Different alarms are available for monitoring the misfire rate. It can also
be defined that the ignition is switched off in the event of output errors. Refer to the section
Inputs/Outputs — Alarms on page 95.

7.8 Schedules A/B
The MIC3+ ignition controllers offer two separate schedules for the parameterization of the
ignition timing and energy.

By closing input Schedule A/B, the listed parameter settings for schedule B can be selected. A
possible application for this is e.g. operation with different gases. If only one schedule is
configured, this is used regardless of the switch position.

You can configure the schedules with the MICT. Refer to Timing — Schedule A/B — General on
page 91and Timing — Schedule A/B — Energy on page 93.

Operational safety!

If you use schedules A and B, the advanced timing point should be linked
to schedule B (switch closure). If a wire ruptures, schedule A is
automatically selected with the retarded (and thus safer) timing point.

7.9 Alarms

The MIC3+ ignition controllers include 16 freely configurable alarms in total.
— Limit for speed exceeded/not reached

— Limit for engine operating hours exceeded/not reached

— Limit for spark plug operating hours exceeded/not reached
— Warning active

— Erroractive

— Limit for temperature exceeded/not reached

— Limit for supply voltage exceeded/not reached

— Limit for global ignition timing exceeded/not reached

— Limit on the analog voltage input exceeded/not reached

— Limit on the analog current input exceeded/not reached

—  Limit of the minimum spark duration exceeded/not reached
— Misfire rate (primary, single output) over limit

— Misfire rate (primary, all outputs) over limit

— Misfires per second (primary, all outputs) above threshold
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— Consecutive misfires (primary, single output) above threshold

— Misfire rate (secondary, individual output) above threshold

— Misfire rate (secondary, all outputs) above threshold

— Misfires per second (secondary, all outputs) above threshold

— Consecutive misfires (secondary, single output) above threshold

A hysteresis can be defined for some alarms. You can configure the alarms with the MICT. Refer
to the section Inputs/Outputs — Alarms on page 95.

7.10 GPO: General Purpose Output

The function of the general purpose output (GPO) can be set as desired as normally closed or
normally open. The GPO can be used for the freely definable alarms.

You can enter the settings for the general purpose output with the MICT. Refer to the section
Inputs/Outputs — Alarms on page 95.

7.1 ASO: Auxiliary Synchronization Output

The ASO is an output of the MIC3+ for synchronizing the MIC3+ ignition controller and a connected
control unit. The possible applications include detonation control, valve control, and fuel injection
control.

The ASO signal is low-active, i.e. the pulse width is defined as the time difference between the
raising and falling edge (pulse width = traising — traing). The raising edge of the signal marks the
configured engine rotation angle. With the variable pulse width, the values can be allocated to the
engine rotation angle.A maximum of 12 pulses can be configured for this purpose.

The pulse width is known at the time of the active edge, as the falling edge of the signal precedes
the raising edge by the value of the pulse width. The controller calculates the duration of the
falling edge from high-level to low-level and then back to the starting value of the high-level.

The ASO signal can be inverted via the configuration. It will then be high-active.

You can configure the auxiliary synchronization output with the MICT. Refer to the section
Inputs/Outputs — ASO1 (Auxiliary Synchronization Output) on page 97.
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EXAMPLE
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Application of the ASO signal

The following example will illustrate the application of the ASO signal:
— Four-stroke engine with 6 cylinders

— Ignition angle 120° - 120°

Synchronization between MIC3+ and Valve Controller

cyl. Lgnition angle in ASO signal in Pulse duration in
crankshaft °crankshaft us

1 0/720 718 160

2 120 118 80

3 240 238 80

4 360 358 80

5 480 478 80

6 600 598 80

Schematic Representation (Standard Settings)

Level
160 s 80 ps 80 us 80 us 80 us 80 us

Hgh b P e __ 4> __ > __ > __ > ___

I 1 I 1 1 ] ) 1 1 1 I I 1

1 1 1 1 1 1 1

I 1 1 1 (] 1

i *)* i At I f ] f i f i f i
1 1 ] 1 1 1 ! 1 1 1 ] 1 1 ~
R, o0 Tieo 1240 360 1480 Teoo . Y
718 118 238 -358 478 508 crankshaft

* active edge

The valve controller should receive the active edge of the ASO signal
before the top dead center of a cylinder. The first pulse duration should
be twice as long and thus mark the beginning of a cycle. The ASO signal
generated by the MIC3+ increases by 2° each time before the ignition
signal from Low to High, as can be seen in the schematic drawing. This
edge is analyzed by the valve controller as the active edge.

The ASO signal drops in accordance with the configured pulse duration
from High to Low before the active edge. The valve controller then has
already measured the pulse duration of the active edge and can provide
information on the allocation of the signal. In the example shown here, the
first cylinder is marked with a pulse width of 160 ys versus 80 us for other
cylinders. If the valve controller measures a pulse width of 160 us, the
subsequent signal is therefore allocated to the first cylinder. The next
signal then corresponds with the second cylinder in the ignition
sequence, etc.
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7.12 Ignition Energy
The ignition energy can be set separately for the start phase and normal operation. Here different
settings can be made for schedules A and B.

You can configure the ignition energy with the MICT. Please refer to the section Timing —
Schedule A/B — Energy on page 93.

7.13 Access Control

The MIC3+ has four operating levels, three of which can be secured with different PINs. As a
default setting, the access control is not activated. If the access control for the MIC3+ is activated,
it is independent from the access levels that control authorizations within the MICT.

Access control in the MICT and on MIC3+

A user is logged in to the Advanced Service access level on the MICT. He

changes a configuration and would like to download the change to the

MIC3+. Although he has the full authorization set in the MICT, he is
EXAMPLE prompted to log in with the PIN for the Level 3 (Master) on the MIC3+.

A variety of functions are at your disposal in the four operating levels of the MIC3+. The figure
below illustrates this:

Level 2: Service

LevelO:ReadOnly | Levell: Operator

Runtime Data Runtime Adjustment Runtime Adjustment
All Timing Reset Position
Energy

Secondary Voltage
Calibration

Commands Commands Configuration

Alarm Commands Set Engine Hours Download to Device
Error Commands Set Spark Plug Hours

Misfire Counter
Timing
Cylinder Individual Offsets

Access Control Access Control

Login Sell Test Reset All Pins
All Enable Access Control
Disable Access Control
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The following functions are available on the different levels:

Level O (Read Only)
Enables read-only access for all users.

Level 1 (Operator)
The user can operate the Alarm Commands, Error Commands, and the Misfire Counter on this
level.

Level 2 (Service)

Only the Service level has access to modifications of the runtime adjustments for Timing and
Energy and the commands Set Engine Hours, Set Spark Plug Hours. The Cylinder Individual
Offsets and the Settings for Self Test can also be executed in this operating level.

Level 3 (Master)

On this level, the Master can, in addition to the other adjustments, modify the Reset Position
and Reset All PINs and Enable/Disable Access Control. This authorization is also needed to
transfer a configuration to an ignition controller.

For information on the access levels in the MICT, refer to the section Access Levels in the MICT
on page 62.
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8 Settings via the MICT

MICT is an abbreviation for MOTORTECH Integrated Configuration Tool. With the MICT, you can
configure your ignition controller, and you can view and adjust the operating data of your engine.
When working with the MICT, you can press the F1key at any time to access context-sensitive
help.

If you are using a different version of the MICT than shown in the following sections, the scope of
functions may differ.

8.1 MICT System Requirements

For the installation of the MICT, the following minimum requirements must be fulfilled:
— x86-compatible computer

— Display with a resolution of at least 1440 x 900 pixels (WXGA+)

— USBinterface 1.1 or higher

—  Microsoft® Windows 10, Windows 11

8.2 MICT Installation

Observe compatibility of MICT versions

& Older firmware versions of certain MOTORTECH devices are not

1 supported by the MICT version provided on the storage device, or are
only supported with restrictions.

NOTICE

When selecting the MICT version to be installed, refer to the compatibility
overview on the storage device supplied with the product.

The software for the installation of the MICT is on the storage device (USB flash drive or CD-ROM)
provided with the ignition controller.
To install the MICT, proceed as follows:
1. Start the installation:
— Viathe menu:

Start the file Start.exe on the storage device. Start the installation routine of the MICT via
Software -> Install MICT.

— Directly from the storage device:
Start the installation routine of the MICT directly. It is on the storage device in the
subdirectory Installation and for example named as follows: MICT-2.48.0-setup.exe.

2. Run the installation.
Follow the instructions of the installation routine. Note that the license agreement terms must
be accepted before using the MICT.
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3. Install the USB driver via the menu as well or directly from the storage device.

— Viathe menu:
Software -> USB Drivers -> Install USB Drivers

— Directly from the storage device:
Start the exe file in subdirectory Drivers (e.g. CDM21226_Setup.exe).

> The MICT is set up. You can connect your PC to the ignition controller via the USB
interface.

8.3 Access Levels in the MICT
Start the MICT on your computer.

In the window Change Access Level, select the access level for which you have clearance. The
access level controls the options you have at your disposal in the MICT. The password required
for access can be obtained from your MOTORTECH contact person (refer to Customer Service
Information on page 150). You can save the password for your access level using the button Save.
It then does not have to be entered again the next time the MICT is started.

B! Change Access Level x

Access Lavel
Read Only
O Customer
O service
(O Advanced Service

Password:

oK Save Cancel

The following access levels are available:

— Read Only
On this level, the user can open a configuration and transfer it to the device. However, he
cannot make changes to the configuration. The user has read-only access to all other
settings.

—  Customer
This level enables the configuration of the basic functions required for operation in addition to
the read-only function.

- Service
This level contains all functions for a standard installation.

— Advanced Service
This level offers full access to all functions of the MICT and is enabled and accessible for
specially trained personnel only.

The following sections describe the options at your disposal with the Advanced Service access
level. If you are logged in to a different level, you cannot execute all functions shown.
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8.4 Configuration Pages (Overview)

The configuration pages are divided into the following sections:

MOTORT=CH-"

M unnamed.mic3* (MIC3+ 3x1,12) - MICT =
E‘E"t Device  Settings  Document  Tools  Help
: ] & T B W — =
B QW9%7 119007 ©
| Configuration Page Parameters
~ Engine Engne Selection Engine Information
[ parametens| :

Cylinder Names
Ignition Qutputs

MAN - E 2842 LE 322

E_ Ignitian Coils Engine Type: 12 cyinder 4-
™ stroke V engne:
Pickups
~ Timing Fiieg Ragias
Analog Inputs 90.0
120.0
v Schedule A 200
General 240.0
330.0
Energy s
~ 450.0
Schedule B £
Generel 570.0
600.0
Energy et
Miscellaneous 0.0
v Inputs/Outputs
Alarms
4501
Inputs
v Miscellaneous
Communication
Information
MOTORTECH does not g base. Pk MOTORTECH If
7)) ssomerces e
1f your engine is not avadsble in the st contact MOTORTECH service pleass.
@ COM4 IDMIC3+ 3¢1.12 (1101 [0000acO1]) ADV.SERVICE Full Access Version: 2430 ™
Pos. Area
Menu bar
Toolbar

Navigation bar

Configuration section

Status bar

The functions in the menu bar, navigation bar and toolbar as well as the configuration section will

be described in the following.

The status bar provides you with the following information (from left to right):

— Status display

Indicates whether a connection is established with the device:

— Green: Connection established

— Red: The connection was interrupted and is being restored

— Gray: The connection is not established and is not being restored
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— Indication of the interface being used for the connection to the device

— Indication of the device ID

— Indication of the access level of the user in the MICT

— Indication of the operating level for the MIC3+ if access control has been activated and the
user has logged on with a PIN.

— Indication of the MICT program version

8.5 Menu Bar and Toolbar

The following functions are available to you via the symbols on the toolbar and the entries in the

menu bar:

Symbol

64

Menu

File -> New

File -> Open

File -> Save /
File -> Save As

File -> Recent Documents

File -> Close

File -> Open trace

File -> Open pickup trace

File -> Change Access Level

File -> Print

File -> Print to PDF File

File -> Print Preview
File -> Quit

Device -> Connect

Function

Creates a new configuration.

Opens an existing configuration.

Saves the current configuration.

The last five configuration files used are offered
for selection.

Closes the current configuration.

Opens a runtime data recording (trace file).
Refer to the section Runtime Data on page 103.

Opens a saved record of pickup signals
(putrace file). Refer to the section Pickup Trace
on page 69.

Changes the MICT access level for accessing
the configuration data and functions.

Prints the current configuration.

Prints the configuration to a PDF file.

Opens a print preview of the configuration.
Exits the MICT.

Connects to the device.
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Symbol Menu

E Device -> Disconnect

Device -> Download to device

N

=

Device-> Upload from device

Device -> Runtime data

Device -> Log

= Device -> Runtime adjustments

Device -> Cylinder individual
offsets

Device -> Self test

Device -> Pickup trace

Device-> Set spark plug
operating hours

Device -> Set engine operating
hours

Device -> Set Date and Time

Device -> Send command ->
Reset misfire counters

Device -> Send command ->
Acknowledge operational error

(Keyboard shortcut: Strg+R)

Rev. 01/2026

Function

Cuts the connection to the device.

Downloads configuration data from the
computer to the device. Refer to Working with
Configurations on page 73.

Uploads configuration data from the device to
the computer. Refer to Working with
Configurations on page 73.

Opens the window Runtime Data. Refer to the
section Runtime Data on page 103.

Opens the window Log (Advanced Service
only). Refer to the section Log on page 128.

Opens the window Runtime Adjustments
(Service and Advanced Service only). Please
refer to the section Runtime Adjustments on
page 129.

Opens the window Cylinder Individual Offsets
(Advanced Service only). Please refer to the
chapter Cylinder Individual Offsets on page 135.

Opens the window Self Test (Service and
Advanced Service only). For this refer to
section Self Test on page 67.

Loads the automatically recorded pickup
signals from the device. Refer to the section
Pickup Trace on page 69.

Opens the window Set spark plug operating
hours.

Opens the window Set Engine Operating Hours.

Opens the window Set Date and Time, in which
you can set the clock in the device.

The misfire counters of all ignition controller
outputs are reset and restarted. Misfires that
previously occurred at the outputs are no
longer displayed.

All operational errors are acknowledged. This
can only be implemented while the engine is not
running.
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Symbol Menu

Device -> Access Control

Device -> Temperature
Extremes

Settings -> Language
Settings -> Online update
settings

Settings-> Database settings

Settings -> Temperature scale

Settings -> Display by cylinders

Document -> Schedule Curve

Tools -> Coils
Help -> Help

Help -> About MICT

8.6 Online Update Settings

Function

The setup for the access control to the MIC3+ is
described in a separate section. Please read the
section Access Control for MIC3+ on page 71.

Opens the window Temperature Extremes in
which the minimum and maximum temperatures
of the controller and output boards are
displayed.

Opens the window Select Language in which
you can change the interface language of the
MICT.

Opens the window Online Update Settings.
Refer to the section Online Update Settings on
page 66.

Opens the window Database Settings in which
various databases can be assigned as source
for the MICT.

Opens the window Select Temperature Scale, in
which you can change the unit for the
temperatures shown in the MICT.

Not currently used.

Opens the window Schedule. Please refer to
the chapter Schedule Curve on page 137.

Opens a database with information on
MOTORTECH ignition coils.

Opens the online help.

Opens detailed information on the MICT.

Perform regular online updates
MOTORTECH is constantly expanding its databases. Perform regular

1 online updates to make optimal use of the opportunities that the MIC3+

provides.

NOTICE
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The MICT uses data from an engine database and a coil database for the configuration. Such data
can be updated with automatic online updates. The settings for the update can be made using the
following entry in the menu bar:

Settings -> Online update settings

! Online Update Settings X

Enable automatic database updates
[[) Use a proxy to access the web
http-Proxy:

Port: 80 =

Show Log Update Now [Il Cancel

You have the following options:

— Enable automatic database updates
Using the check box, you can enable and disable automatic online updates. As the default
setting, the online update is enabled and is executed daily (if an internet connection is
established) at first start-up of the MICT.

— Use aproxy to access the web
Use the checkbox to activate settings for internet access via a proxy server, which you can
then set up by entering http-Proxy and Port.

- Show Log
With this button, you can open a window in which the online updates performed are logged.

— Update Now
With this button, you manually start an online update.

8.7 Self Test

Operational safety!

If you carry out a self test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.

You can run the self test via the MICT to check the order of the wiring and the connection between
the ignition controller outputs and the spark plugs. From firmware version 1.11.00000, the running
self-test is signaled on the device by the status LED flashing once (1 time orange 250 ms on,

750 ms off). Refer to the section LED Functions on page 24.
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Proceed in the MICT as follows:
Device -> Self test
M Self Test - (] X
WARNING

Inusing the self test feature it is critical that the fuel to the engine has
! been shut off and the engine purged of any fuel gas. Faiure to do this
could result in d |

n ge to and nearby
Status Cydes Cydle Time - All Configured Outputs
© Uninited O period 000 [3] bs
P Lo O Lz O Fraquency 250,000 [3] Hz
Active Outpuls Contrel
- Ou
D Ready

<60 Fsm  PRses
@ COMS ID MIC3+ 3x1.12 (1.10.1 [0000ac01))

The following information is provided:

Status
The status displays indicate whether the ignition controller is ready for the self test.

- Locked
The ignition controller is in a state in which no self test can be done. For example, there is an
error or a configuration is currently being downloaded into the device.

- Active
The self test is running.

- Ready
The ignition controller is ready and the self test can be started.

You have the following options:

— Cycles
Determine whether the self test should run unlimited or be terminated after a defined number
of cycles.

— Outputs
Define whether all outputs or only a defined output should be fired during the self test.

— Cycle Time - All Configured Outputs
Specify the cycle time either as a period or frequency. The value entered always refers to a
complete cycle. That means that all outputs that are configured are fires once per cycle. If you
only set one output for the self test, this would still only fire once per cycle.

— Control
Start or stop a self test using the corresponding buttons.
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8.8 Pickup Trace
The traces of the pickup signals support you in checking the behavior of the used pickup and thus,
for example, to detect and analyze irregularities or failures.

Pickup signals are automatically recorded by the ignition controller as soon as they are detected
at the configured inputs. Ten further signals are recorded if an error occurs during operation
(cumulative across all inputs). The recording is then stopped so that the pickup signals just before
the error can be analyzed. The records can be downloaded from the device at any time.

Proceed in the MICT as follows:

Device -> Pickup trace

Pickup trace
Example of a pickup trace for a configuration with two pickups:

—  Pickup input 1 (cam):
Single event from the camshaft

EXAMPLE

— Pickup input 2 (trigger):
Trigger disc type N-1with 160-1 events from the crankshaft

’ A

— ' . o ]
16,500 17,000 17,500 18,000 18,500
Time [ms]

Operation
The following options are available via the menu in the window:
- Open

Opens a previously saved pickup trace.

- Saveas
Saves a pickup trace as a .putrace file.

— Close
Closes the pickup trace.
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There are the following options for the display of the pickup signals:

Zoom In/Out

Using the mouse scroll wheel you can zoom in and out of the displayed record range.
Alternatively you can also use the plus and minus keys on the keyboard. With the zoom
function, you can e.g. analyze the trigger signal more precisely (see figure).

ML MICT - Pickup Trace - a x
Eile
Pickup Trace

Pickup Input

T T b T 1
17,400 17,450 17,500 17,550 17,600
Time [ms]

Move displayed range
With the right mouse button pressed you can move the displayed range along the time axis.

Measuring

You can measure distances and the number of events in the displayed range by holding down
the left mouse button to highlight a section. You can find the following information in the
window:

— Position on the time axis
— Time difference (A) between the two selected points
— Number of events counted in the selected period
M MICT - Pickup Trace - a x

Eile
Pickup Trace

f A ||||H|||||||\IIIIIIIIIIélHIIII A

135071,459 ms i
&= 1631463 ms i

Input 1 (positive): 8 events, min. i)edod 199,919 ms, max. period: 199,922 ms

——
120,000 125,000 130,000 135,000 140,000 145,000
Time [ms]

Error Analysis
The pickup traces support you, for example, in analyzing the following errors:

70

Configuration of the pickup does not agree with the wiring (e.g. trigger disc configuration,
allocation of the inputs, allocation of the shafts). In this case, you should compare the values
configured with the signals recorded (see Engine — Pickups on page 86).

One or more pickups have failed.
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Pickup trace
. The pickup signals are only recorded on the inputs that are configured in
1 the MICT. No signals are recorded if the pickup input configuration is not
valid.
NOTICE

8.9 Access Control for MIC3+
If the access control to the MIC3+ is activated, access to the following areas is possible with a PIN
only:

— Runtime Adjustment (Reset, timing, energy, secondary voltage estimation calibration and
secondary short calibration)

— Commands (Alarms, error commands, set engine/spark plug operating hours, and self test).
— Configuration (Transferring a configuration to the MIC3+)
The access control regulates the accesses to the device via the MICT. For explanations

concerning access control of the MIC3+ and the delimitation of the access levels in the MICT, refer
to section Access control on page 59.

The access control functions can be accessed in the menu bar via:

Device -> Access Control

8.9.1 Enabling/Disabling Access Control

Enabling and disabling access control

. As a default setting, the access control is not enabled, and all PINs are set
1 to 0000. Once the access control has been enabled and the PINs have
been changed, these PINs will continue to be used. To re-enable the
NOTICE access control, you will need the PIN for level 3 (Master). It is therefore

recommended to reset all PINs before disabling.

If that was not done, or a system must be unlocked for another reason, a
request key can be issued in the MICT. Refer to the section Reset All PINs
on page 72.

To enable or disable the access control, proceed as follows:

1. Open the input dialog via Device -> Access Control -> Enable or Disable Access Control.
2. Enter the PIN for the level Master (level 3).

3. Confirm the input with OK.
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8.9.2 Login/Logout

If the access control is enabled, you are prompted to log in if you want to execute functions that
are allocated to a specific operating level. In addition, you can log in specifically to an operating
level via the menu bar.

To log into a specific operating level, proceed as follows:

1. Open the input dialog via Device-> Access Control -> Login.
First select the level you wish to log on to.

Enter the PIN for the desired level.

Confirm the input with OK.

> Youare now logged into the corresponding level and can execute all functions that are
allocated to this operating level without having to log in again.

> oD

After completing the log-in, you can log out again as follows:

Device -> Access Control -> Logout

8.9.3 Changing the PIN

To change the PIN for a specific operating level, proceed as follows:

1. Open the input dialog via Device -> Access Control -> Change PIN.
First select the level for which you wish to change the PIN.

Enter the current PIN for the desired level.

Enter the new PIN in the two subsequent fields.

Confirm the input with OK.

> The PIN for this operating level has now been changed.

a kw0

8.9.4 Reset All PINs

To reset all PINs, proceed as follows:
1. Open the input dialog via Device -> Access Control -> Reset All PINs.

2. If you are not yet logged into the Master (level 3) level, you will be prompted to log in with the
relevant PIN.

3. Confirm the input with OK.
To reset all PINs, you will be prompted again to enter the PIN for the level Master (Level 3).
Confirm the input with OK.
> Al PINs are now reset to the value 0000.
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To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in
case of emergency that was locked in this way, you have the following option:

1. Inthe menu bar, select the entry Device -> Access Control -> Get reset all PINs request key
to open a window with the same name.

2. Send the request key with the serial number to your service contact person at MOTORTECH
(refer to Customer Service Information on page 150). This key is valid only for the respective
controller and only for a certain amount of time.

»  Yourinformation will be verified, and you will receive an authorization key from your
contact person.

3. From the menu bar, select the entry Device -> Access Control -> Set reset all PINs
authorization key to open a window with this name.

Enter the authorization key received in the input field.
Confirm the input with OK.
> If the input was correct, all PINs are reset to the default value 0000.

8.10 Working with Configurations

To ensure that the MIC3+ correctly interprets incoming data and correctly controls the ignition
system, it requires information about the engine and the ignition system. This information is
stored in the MIC3+ as configuration data.

You can use the MICT to perform the following for these configurations:
— Create

- Open

- Edit

— Saveasafile

— Download to the MIC3+

— Upload from the MIC3+

Rev. 01/2026
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8.10.1 Create, Open, Save

Click on the symbol to create a new configuration and select the corresponding
| W device type. The device type corresponds to the first five digits of the

— arrangement number, which you can find on a label on your device.

! Select Device Type x

Selact the device type you want to configure:

~ Ignition Controllers
> MICI0O
> MIC3 —— —
o Mics. OTORTECH' MIC3+=
MIC3+ 3¢1.06 (6 outputs) _—
[MIC3+ 3x1.12 (12 outputs) &
> MIC4 | P/IN 123 | 3
> MICS B
> MICG | A I 5
S AN 3x1.12 XXXX-XXXK-XX-X g
i S"”{,’:;;::‘“‘C“"" [ SIN 01008086 | 2
VariStep3
¥ Integrated Throttle Bodies
ITB-DC
(o ) ome
= Click on the symbol to open a saved configuration.
™! Open Configuration File x
IS TR N ]« 0S(.> MICT... ~ @G | SearchMICT Configuration 0
Organize * New folder =~ 0O @
Narvie - Date modified Type Sixe
& Enginel.mic3 6/10/2021 8:26 AM MIC3 Config File 13KB
¥ Engine2.mic3 6/10/2021 8:26 AM MIC3 Config File 13KE
"cﬂ! Engine3.mic3 6/10/2021 8:26 AM MIC3 Config File 13KB
File name: {Enginﬂ.mi:! v‘ IMICB Configuration Files (*.mic VI
Click on the symbol to save the configuration currently displayed in the MICT to a
E storage device.
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Compatibility of the configuration files

. Configuration files are only compatible for the respective device type,

1 even if the file extension is identical. For example, files created for an
MIC3 cannot be downloaded to an MIC3+ and vice versa.

NONIEE To use a configuration for another device, the series and the first four

digits of the arrangement number must match. This information can be
found in the title bar of the configuration and on the respective device:

MIC3 MIC3+
W urmam:d.mi MIcT w unnamed.mi MicT
Fle Device Setings Document Tools Help Fle Device Setlings Document Tooks Help
A, 48" AERSRS 44"
Parameters | Parameters

Canfiguration Page
Engne Selector | |, g Engne Selector

OTORTECH'
| |

KNN 3)(1.12)(XXX‘XXXXAXX~X ‘ N 3;.-1‘_2)xxx—xxxx~xwx [

If, for example, a system is to be changed from an MIC3 to an MIC3+, the
configuration of the MIC3 can be saved as a PDF file. Then a new
configuration file must be created for the MIC3+ and the values from the
PDF file must be entered. Alternatively, the MICT can be opened twice
and the values transferred to a newly created configuration file.

| Cenfiguration Page
|~ [Engine

OTORTECH'
[PIN_1234 |

www.matortech.de
www.malortech.de

8.10.2 Upload, Download
= Click the symbol to upload the current configuration from the MIC3+ to the MICT.

S @ If applicable, the MICT first establishes a connection to the MIC3+ connected.
gu Click on the symbol to download the configuration set in the MICT to the MIC3+.
;@ This function can only be executed while the ignition is not active. This action

= overwrites the existing configuration on the device. If applicable, the MICT first

establishes a connection to the MIC3+ connected.
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Existing configuration is cleared!
°

|

NOTICE

If you download a configuration to an MIC3+, the previous configuration is
deleted and the new settings are immediately implemented.

Runtime adjustments

-4 If you change a configuration stored in the MIC3+ via runtime adjustments,

1 the configuration must be re-uploaded from the device so that the
changes are displayed in the MICT's configuration views.

NOTICE

8.10.3 Compatibility Information

M Information X

Some configuration values could not be loaded from the file. Assuming default values. You should recheck the i
Ioaded configuration. =

oK Show Detais...

If you upload a configuration from the MIC3+ to the MICT that does not correspond to the version
of your MICT, or if you open this type of configuration in the MICT, the following situations may
occur:

— No values are present in the configuration for certain MICT functions. The MICT assumes the
standard values for these functions.

— The configuration contains values for functions that are not support by the MICT.
The following situations can occur if you download a configuration from the MICT to an MIC3+
whose firmware does not correspond to the version of your MICT:

— Novalues are present in the configuration for certain firmware functions. The firmware
continues to use the preset values for these functions.

— The configuration contains function values that are not support by the firmware.
If you download a configuration into the MIC3+ and are notified of functions that are not supported

by the MICT, you should check the MIC3+ settings. Re-upload the configuration from the MIC3+ to
the MICT. You can then see in the MICT which settings were not applied.

Perform a firmware update, if necessary, and/or update your MICT so that you can use all the
MIC3+ functions without restriction.
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8.11 Configuration

The window opens after you have selected the device type for a new configuration or an existing
configuration or have uploaded one from the ignition controller. You can make changes to the
configuration by selecting an entry from the navigation bar. The corresponding configuration data
are then displayed in the configuration section and can be edited by you. The following sections
describe the settings you can implement in the different areas.

Indication of invalid entries

An invalid selection or invalid input values are highlighted by pulsating
1 warning signs in the configuration pages of the MICT. Additional
information is provided in the status bar.

NOTICE
Example:
Configuration Page | tgriton Outputs
~ Engine ‘ Output Bank A
Parameters.
Number of Outputs: & -

Cylinder Names
7 Ignition Outputs
Igniticn Cails

Pickups
> Timing ‘
~ Inputs/Outputs

Alarms.

ASD1

Inputs
v Miscellaneous

Communication

Information

1
2
k]
4
v (5 -
L]
7
&

ing Angle: 0.0 - 720.0, Default = 0.0, min. distance imited by overspeed (invalid due COMn/a IDn/a ADV.SERVICE n/a Version: 2480
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8.11.1 Engine — Parameters

M unnamed.mic3® (MIC3+ 3x1.12) - MICT

= a x
Eile Device 3ettings Document Tools Help
=S ca =2 O : = =
JuEdFHS Il YSNEO0E
Configuration Page
v [E Engine Selection Engine Information
Engne Manufacturer  Series Type New Engine Configuration Selected Engine Summary
Cfieder Names ATAX E 03 Series E 2842 E 302 MAN - E 2842 LE 322
Ignition Qutputs Caterpillar E 26 Series E 2842 E 312 L
Ignition Cails Clazk E 28 Series E 2842 LE 202 Fagine Type 12 cfen &
Pickups Cooper Bessemer | [E 32 Series E 2842 LE 302 i
™ E 2842 LE 312 DFIBB!gAnqhs
Ardfog Inputs Guascor E 2842 LE 322 0
7 Ingersoll Rand E 2842 LE 332 120.0
chadule A Jenbacher E 2848 IE 322 210.0
General Liebherr E 2876 E 302 zns
[ Energy MR E 2876 E 312 0.0
. Schedule B Nordberg E 2876 LE 202 450.0
N ! Ruston £ 2876 LE 212 ﬁ‘g
Genera Sequence E 2876 LE 302 00,0
L Energy Superior E 2876 TE 302 690.0
) Miscellanecus Haukesha 0.0
~ Inputs/OQutputs
=
L Alarms
ASO1
7 Inputs
~ Miscellanecus
= -
i1 Communication
| Information

fi‘\ discrepancies are found.

If your engine is not available in the list contact MOTORTECH service please.

MOTORTECH does not assume liabiity for the information in the engine database, Pleasa contact MOTORTECH if

@ COM4 IDMIC3+ 3x1.12 (1.10.1 [0000ac01]) ADV.SERVICE Full Access Version: 2.48.0

Engine Selection

The MICT holds an engine database with data from various manufacturers and model series.
Select the desired engine manufacturer, series, and type by clicking on the corresponding fields.

78
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Wiring in firing order is assumed as standard. If straight order wiring is supported for the selected

engine, the Wiring dialog opens and you have the opportunity to adapt the output configuration.

! Wiring ? x
Pleasa select the type of wiring you are using.

In case of custom wiring please select wiring in firing order and adjust the
output configuration afterwards.

O wired n firing order
© wired in straight order (user defined orientation)

Coil 1 7|0 o 1
s| o] [o] |2
sl [o |o||s
w|lo]| |of|+
1] |0 o 5
12| |0 o & Coil 1
Or:58 [FIFTFIED O£
o 7-12 m o 14

change orientation of rall | change harness  change orientation of rail

[ ]

You can use straight order wiring, if:

— Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing

order needs to be configured directly in the ignition controller. The ignition coils on the wiring
rail are marked with Connector Pin 1to Connector Pin X. The position of coill on the wiring rail

is marked in the view Wiring.

— Wiring of the ignition controller is done corresponding to the instructions in section Straight
Order Wiring of the Ignition Outputs on page 48 (for example with an open wiring harness or

via a junction box).

The configuration of the ignition outputs is automatically adapted corresponding to your selection.

If you want to use a different wiring, these settings must be adapted appropriately.

If the relevant engine is not available in the database, settings can also be made by selecting the
corresponding sequence. For this purpose, click on the entry Sequence in the column Engine
Manufacturer and select the firing stroke as well as the number of cylinders in the column Series
and the required ignition offset of the engine. After making your selections, a summary of the
selected parameters will be displayed in the section Engine Information on the right.

The summarized data are transferred to the subsequent configuration page Ignition Outputs. The

values displayed there can only be changed by users with authorization to access the Advanced

Service level.
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Engine database

. MOTORTECH does not assume liability for the information in the engine
1 database. Please contact MOTORTECH if discrepancies are found.
NOTICE

New Engine Configuration

Personnel with authorization for the Advanced Service level additionally has the option of setting
the engine data manually, i.e., without selecting from the engine database. For this purpose, click
on the New Engine Configuration button and select the engine type, the number of strokes, and
number of cylinders in the dialog box that subsequently opens. Additional information can be
entered on the configuration page Ignition Outputs.

! New Engine Configuration x
Engine Type: V engine !
Strokes: 4stroke &
MNumber of Cylinders: 12 -

Note: Spedify Firing Order and Firing Angles on the Ignition Outputs Page!

(o ) camce
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8.11.2 Engine — Cylinder Names

M unnamed.mic3® (MIC3+ 3x1.12) - MICT - ] x

Eile Device 3ettings Document Tools Help

QA EHY SRS R EBO0EE @

Cylinder Names

Configuration Page

~ Engins @ Enzbie Cyinder Names
| Parameters

|| Ignition Qutputs
Ignition Coils O
] Pickups ol
~ Timing 8
1| Analog Inputs

~ ] Schedule A 3

Bank Name: B Bank Name: A

ol

" General
=
" Energy
~ [ Schedule B 11
N
General

(00O 0 O O O
(0O 0 0 O O ©
&

] Energy

H‘

" Miscellaneous
~ Inputs/Qutputs

=Y

L Alarms

7 ason

>

i Inputs
~ Miscellanecus

™ -

Communication

2
z
&

I Information

[ Show banks in reverse order

& COM4 IDMIC3+ 3x1.12 (1.10.1 [0000ac01]) ADV.SERVICE Full Access Version: 2480

To facilitate the allocation of the cylinders during the configuration of the ignition outputs, you can
individually name each cylinder. The schematic representation of the plan view of the selected
engine supports you in this. Make the following settings:

— Enable Cylinder Names
Activate the checkbox in order to assign cylinder names. In order to use this function, the
number of cylinders must be defined. Establish the number of cylinders either by using a
configuration from the engine database or by creating a new engine configuration via the
corresponding button. On this, refer to the section Engine — Parameters on page 78. If you
have activated the checkbox, the assigned cylinder names must also be assigned to the
corresponding ignition outputs, before the configuration is transferred to the ignition
controller. Otherwise there will be an error message. Refer to the section Engine — Ignition
Outputs on page 82.

— Bank Name
Enter a name for the respective cylinder bank.

— Cylinder Names
Enter a name for the respective cylinder.
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[oR
- o3
currently not used

— Show banks in reverse order
currently not used

8.11.3 Engine — Ignition Outputs

M unnamed.mic3” (MIC3= 3x1.12) - MICT - m] X

Eile Device 3ettings Document JTools Help

LAUESHS § %%

Configuration Page Ignition Outputs
« [Engine Output Bank A
[ Parameters
Number of Qutputs: | 12 -

Cylinder Names

Ignition Qutputs e Output )

Ignition Coils
" 7 bt 1 * | 450.0
[ Pickups
~ Timing 8 {4 v 210.0
7 Analog Inputs s =1 e = %00
~ 7] Schedule A
\ 10 >ls ~ | 330.0
| General
M e 1 -1 [10 ~| 570.0
| Energy
~ [ Schedule B 2 ][z - 9.0
5
General 1 *|[1 v 0.0
S Energy 2 <1fe ~ =00
{7 Miscellaneous
~ lInputs/Outputs 3! a1 L v 2900
) Alarms 4 > 1 ~ 600.0
Ll ason s -3 - 1200
| Inputs
6 ¥ |7 ¥ 350.0

v Miscellanecus
™ -
Communication
7 Information

@ COM4 IDMIC3+ 3x1.12 (1.10.1 [0000acO1]) ADV.SERVICE Full Access Version: 2.48.0 4

Make adjustments to the following settings as needed:

— Number of Outputs
Select the number of outputs.

—  Column: Cylinder
Select a cylinder. The displayed names are specified on the configuration page Engine —
Cylinder Names.

—  Column: Output
Select the number of the respective output.

— Column: Angle
Enter the firing angle for each output.
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Default Application

If you select from the engine database, the data stored for the selected configuration are
displayed. These data can only be changed by personnel with access to the Advanced Service
level.

New Engine Configuration

Selecting the number of outputs enables access to the fields for the configuration of the outputs.
By default, the ignition outputs are distributed so that cylinder 1 of the ignition sequence is always
allocated an ignition angle of 0°. The ignition angle for each output results from the addition of the
ignition spacing to the respective previous output.

Operational safety!

Never connect more than one output to each ignition coil, as the output
boards can otherwise be damaged.

The allocation of outputs to the device's output connector contacts and the cylinders is
determined by the wiring. The user must take the wiring into account during the configuration; it
cannot be checked by the software.

Interval between two ignitions

. The interval between two ignitions must be at least 1.7 ms. During the
1 check, the configured overspeed is used in the calculation.

NOTICE
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8.11.4 Engine — Ignition Coils

M unnamed.mic3® (MIC3+ 3x1.12) - MICT - ] x

Eile Device 3ettings Document Tools Help

UHFHS IS E0EEA ©

Configuration Page mh?? Coils
v [Engine Ignition Coil Type
[ Parameters Coil Type: | 06.50.104 - 2 v i i o

Cylinder Names u = i
Ignition Qutputs e ¥ Yollaze ESation Calbvatcn

1 Ignition Cails Output Offset

|| Pickups Al 0.0 =
~ Timing

A2 0.0 E
[] Analog Inputs =
~ ] Schedule A A3 0.0 £
" General A4 0.1
o
_ L Energy AS 0.0
~ [7 ScheduleB
> A5 0.0
General
|} Energy AZ 0.0
i Miscellanecus AB 0.0
~ Inputs,
pu;\.fOutpu‘!s A9 0.2
L Alarms
0 ason A10 0.0
7 Inputs Atl 0.0
v Miscellaneous o 0.0
[E) . ” -
1] Communication
] Information Secondary Shart Detection Calibration

Secondary Short Enable Voltage: 0.420

Secondary Short Sensitivity: 0.9800 -

@ COM4 IDMIC3+ 3x1.12 (1.10.1 [0000acO1]) ADV.SERVICE Full Access Version: 2.48.0

Ignition Coil Type
Select the ignition coil type from the drop-down list. (Without this selection the configuration
cannot be downloaded to the MIC3+.)

Only use measured ignition coils

To operate the MIC3+, only ignition coil types measured by MOTORTECH
1 may be used. All ignition coils used must correspond to the part number

selected in the drop-down list. Different coil types must not be mixed and
NOTICE also no equivalent or replacement types may be used.

If a coil type used is not in the drop-down list, then the MIC3+ is currently
not used.
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Secondary Diagnostics Enabled

The secondary diagnosis can be deactivated and activated for ignition coils that support this
function. If the ignition coil does not support this function, the secondary voltage estimation
calibration and the of the secondary short calibration are not available.

Secondary Voltage Estimation Calibration

A correction value without units can be set for the secondary voltage estimation for every
configured output to increase the accuracy of the secondary voltage estimation for each individual
cylinder. This allows, for instance, different cable lengths on the engine to be compensated.

The values of the secondary voltage estimation can be changed for each individual cylinder. The
value range depends on the ignition coil. 0.0 is set as the standard value for all cylinders. You can
adjust the secondary voltage estimation while the engine is running in the runtime adjustments
(refer to Runtime Adjustments — Secondary Voltage Calibration on page 133).

Secondary Short Detection Calibration

The starting voltage and the secondary short detection sensitivity can be adjusted. You can adjust
the secondary short detection in the runtime adjustments while the engine is running (refer to
Runtime Adjustments — Secondary Short Calibration on page 134).

Secondary Short Enable Voltage
Set the average ignition voltage required to activate the secondary short-circuit monitoring:

— The secondary short detection is always activated at a value of 0 kV.
— The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
— The sensitivity is high at a value of 0.98.
— The sensitivity is low at a value of 1.02.
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8.11.5 Engine — Pickups

M unnamed.mic3® (MIC3+ 3x1.12) - MICT

a X
Eile Device 3ettings Document Tools Help
e = = @ |: _— . o
: Y — o |: [ .5 :
JuHSES Rt EOE
Configuration Page Piclops ;
v Eome Pickup Setup Information
I Parameters 2PU (trigger disc with N events on camshaft (passive) and 1 event (active high) on camshaft)
Cylinder Names
Ignition Qutputs Input L (Cam): trigger disc type SINGLE EVENT and active high pick up on camshaft
[ Ignition Cails Input 2 (Trigger): trigger disc type N with 160 events and passive pick up on camshaft
F‘] Pickups
~ Timing Pickup Setup
S
L] Analog Inputs Predefined Setup: | 20U - User-defined
v~ [ Schedule A
General Index/Reset Position:  50.0 BIDC ¥ Adjust
1 Energy Pickup Sensitivity: medum -
v [ Schedule B
™ General Trigger Mumber of Triggers: 160
S
Energy
E: Miscellaneous
A \nput_s/Outpms Aux Pickup Supply Voltage
Alarms
L ASOY Aux Pickup Supply Voltage: 5.0 |2] v Please ensure the correct voltage setting
3 P Y et 3.0 o) for your applcation.
L Inputs
v Miscellaneous
1 Communication SpasdSettn
17 Information Ignition Release: 150
Security Speed: 250
Nominal Speed: 1500
Overspeed: 2000 |
Max. Power-On Speed: 6000

@ COM4 IDMIC3+ 3x1.12 (1.10.1 [0000ac01]) ADV.SERVICE Full Access Version: 2.48.0

Active pickups
-4 Check when using active pickups that the auxiliary supply voltage is

1 configured in accordance with your application.

NOTICE

Pickup Setup Information

The settings made in the section Pickup Setup were summarized once again in the section Pickup
Setup Information.
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Pickup Setup
In this area, make the following settings:

Predefined Setup
Select the pickup configuration suitable for your application from the list. The configurations
available for selection depend on the previously entered settings.

Index/Reset Position
Enter the distance between the first event after the set index/ reset marking and top dead
center. With the button Adjust, you can enter the measured firing angle for a given nominal
value. The system calculates the difference from these values, which is added to or
subtracted from the index/reset position.
Pickup Sensitivity
Open the pick list and select the desired sensitivity level for the pickup. This setting
overwrites the value of the pre-trigger voltage if the latter was defined in the user-defined
pickup setup.
— High
The signal processing starts at low engine speeds. This setting can result in increased
susceptibility to failure.

—  Medium
Default setting for MICT. This is a trade-off between start-up speed and sensitivity.

- Low
The signal processing does not start until high engine speeds are reached. This setting
can result in reduced susceptibility to failure.

Trigger/Cam No. of Triggers

Enter the number of events. The input Cam or Trigger is automatically selected by the MICT
and is governed by the selection of the pre-defined pickup settings.

User-defined

Staff authorized to access the Advanced Service level can, in addition to the standard settings
access, use a manual setup option by clicking on the button User-defined.

™! Pickup Setup x

Pickup Inputs.

Tnput Type Number of Events Speed Active/Passive | Pre-Trigger [V]

PidwpInput 1 (Cam}:  SINGLE EVENT v 0 CAMSHAFT  ~  activehigh ~ 2.5 =

Pickup Input 2 (Triggerk N - 180 CAMSHAFT  ~  [passve  ~ 1.5 =
o | o

Tigger Disc Type, Default = NONE
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88

Type

You can select the type of events that will occur on this input for each pickup input. Type
and number of events are defined by the discs or ring gears used. If you decide not to use
a pickup input, select the entry None from the list. You can set the following types:

Disc, which causes a uniformly distributed number (N) of events (per rotation), e.g. a ring
gear with 160 teeth (N=160).

N+

Disc type N with one additional event, e.g. a disc with 12 teeth and one additional tooth for
the index signal (N=12).

N+1 Extended Index Range

Disc type N with an additional event, e.g. with one disc with 12 teeth and one additional
tooth for the index signal (N=12). The permitted range for the index signal is expanded to
75 % of the tooth period. An incorrect direction of rotation of the engine cannot be
detected by this setting.

N-1

Disc type N, where one event is missing, e.g. a ring gear with 160 teeth on which one
tooth was removed (N=160). This missing event is used to determine the index signal

N-2

Disc type N, where two consecutive events are missing, e.g. a ring gear with 60 teeth on
which two teeth located next to each other were removed (N=60). This missing event is
used to determine the index signal.

N Magnets, Single Magnet

You will always use these two types together for a disc with magnets having opposite
polarity. A magnet with a fixed number of magnets (N), all of which are arranged at equal
distances on the disc, has a reverse polarity. Thus, the disc supplies two signals that can
be analyzed by a pickup.

Single Event

Disc that supplies a single event, e.g., a disc with one tooth or one magnet.

Number of Events

Enter the number of events that occur on the pickup if more than one event is expected.
For the types N+1and N-1, enter the value for N and not the total number of events. With
the type N Magnets, the number of magnets with identical polarity must be entered.

The number of events must lie between 3 and 500. Additionally, it must be taken into
account that the sum of the frequencies at the pickup input does not exceed the limit of 10
kHz at the pre-set overspeed.

Speed
Select whether the respective pickup will pick up the signal off the camshaft or the
crankshaft.

Active/Passive

Select the pickup to be used from the pre-defined pick list:
Passive

passive pickup

Active (low)

active pickup with high level as quiescent level

Active (high)

active pickup with low level as quiescent level
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— Pre-Trigger
Enter a value between 0.1V and 7.5 V for each pickup to set the pickup sensitivity. Signals
that fall short of the set voltage will not be analyzed. A low pre-set value therefore results
in a high sensitivity level, a high value results in a low sensitivity level.

Pickup setup information

-4 The respective latest setting in the area of the pre-defined or arbitrary

pickup settings is transferred to and displayed under Pickup Setup
Information.

|

NOTICE

Auxiliary Pickup Supply Voltage
Enter the supply voltage with which the active pickup is to be operated. A value between 5 and
24V is possible.

Speed Settings
In this area, make the following settings:

Ignition Release
Enter the release speed for the ignition at which the first ignition is to fire. The value shall not
exceed 1/7 of the nominal speed.

Security Speed

Enter the security speed. Below the value entered, the ignition can be switched on and off as
desired. If the ignition is deactivated during operation above the set speed, the ignition cannot
be immediately reactivated. Only when the ignition no longer reads a speed, i.e., the engine
has come to a standstill, can the ignition be reactivated.

Nominal Speed
Enter the nominal speed at which your engine is to be operated. With engines that are to be
operated with variable speeds, the max. speed of the operating range must be entered.

Overspeed

Enter the speed at which the ignition is to be shut off as overspeed protection. With engines
that are to be operated with variable speeds, a speed above the operating range must be
entered.

Max. Power-on Speed

Enter the maximum permitted start speed at which the MIC3+ starts sending ignition pulses.
A value of 6000 rpm is set as the default value: The MIC3+ can be activated at the starter
speed and immediately send ignition pulses.

For a value of 0 rom the MIC3+ can only start sending ignition pulses once it has registered
that the engine is at a standstill.
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8.11.6 Timing — Analog Inputs

M unnamed.mic3® (MIC3+ 3x1.12) - MICT
Settings

Eile Device Document  Jools

Configuration Page
~ [Engine
I Parameters
i Cylinder Names
Ignition Qutputs

| Ignitien Coils
B Pickups
~ Timing
1 Schedule A
7 General
7 Energy
~ ] Schedule B

) General

Help

BEEE-PIIR R TN =11

Analog Inputs Base Settings
Analog Current Input
Lower Limit: 4.0
Upper Limit:
Failure Threshold: 3.2

200

Analog Voltage Input
Lower Limit: 0.0
Upper Limit: 5.0

Faiure Threshold: 0.0

Aux Analog Input Supply Voltage
Aux Analog Input Supply Voltage:

3 Energy

7 Miscellaneous
“ Inputs/Qutputs
" Alarms
1 AsOl

7 Inputs
v Miscellaneous

| Communication

[ Information

@ COM4 IDMIC3+ 3x1.12 (1.10.1 [0000ac01]) ADV.SERVICE Full Access Version: 2.48.0

Auxiliary supply voltage
-4 Check with the configuration of the analog inputs, that the set auxiliary

supply voltage corresponds to your application.

|

NOTICE

Analog Inputs Base Settings
The ignition timing adjustment can be made using two analog input signals, which can be set
within the following limits:

— Analog current signal: 0-20 mA
— Analog voltage signal: 0-10 V
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8 Settings via the MICT

Set the Upper Limit and Lower Limit of the signals corresponding to your connected device. Also,
you have the option to enter a Failure Threshold. If the signal does not reach this value, it is
classified by the ignition controller as failure (e.g. wire break). The error value configured in the
schedule was set for the affected input. To reset the error state, a threshold will need to be
exceeded. This threshold value is calculated as follows:

Threshold to reset the error state > 0.5 x (Lower Limit - Failure Threshold) + Failure Threshold

You set the analog input that will be used and which timing adjustment results from the analog
signal for the two possible schedules. Refer to the section Timing — Schedule A/B — General on

page 91.

Aux. Analog Input Supply Voltage
An auxiliary supply voltage can be configured for the analog inputs. Enter a voltage value between

5Vand24V.

8.11.7 Timing — Schedule A/B — General

M unnamed.mic3* (MIC3+ 3x1.12) - MICT = o X
Eile Device 3ettings Document Tools Help
SR RS 4 <d O Fh = = > e
JuHSHS M EBO0EE ©
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o Min/Max Timing Point 2: 0.0 ATDC ¥ Min/Max Individual Limit 2: 0.0 RET  ~
Pickups
~ Timing Base Timing 1B Speed Curve
S
|| Analog Input:
b fnakog npos 16.0 BIDC ¥ Number of Speed Points: |3 ¥
v 1 Schedule A
General [ Potentiometer Function font  Speed RM]  Timing [ AdvRet
Energy Clockwise: 0.0 RET ¥. 10 0.0 AV~
~ [ Schedule B . 9 = —
™ ounter Clodkwise: ek -
) General AL \ 2 700 0.7 RET
7 Energy 8 Analog Current Input 3 1200 1.0 RET  ~
| Miscellaneous AtLower Limit (.0 mA): 5.0 ADV - 4 0 0.0 RET &
¥ InputsfQuiputs i s 0 0.0 ET ¥
D Alarms At Upper Limit (20.0 mA): 5.0 RET hd g e
[ asor Default: 0.0 RET  ~ SEg 0.0 Wb
17 Inputs 7 0 0.0 RET -
~ |Miscellaneous 8 Anslog Voltage Input F 0 0.0 RET
p— . RE =
- Communicaticn AtLower Limit (0.0V): 5.0 AV ¥
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Default: 0.0 RET v
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8 Settings via the MICT

Schedule A General Settings

The MIC3+ offers two schedules for implementing the necessary settings for the timing of the
engine. The schedules A and B can be used for dual fuel operation, for example. The system
switches between the schedules via the input Schedule A/B. If only one schedule is configured,
the switch is ignored. The configuration options for schedule B are identical to those for set A.

— Enable Schedule
The settings are enabled or disabled by checking/unchecking the box. One schedule must
always be activated.

— Description
Enter a description for the schedule (e.g. natural gas for the setting for this type of gas).

Limits

Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs
will be limited to this range relative to the respective top dead center of the pertinent cylinder. The
global timing can then not be shifted beyond this range by any adjustments.

Base Timing
Enter the timing specified by the engine manufacturer. This point must be within the limits entered
and is a static portion of the global timing.

Analog Current Input/Analog Voltage Input
The analog inputs can be enabled and disabled by clicking. If you have the choice, you should
prefer the analog current input due to its lower sensitivity to faults.

Enter the values by which the adjustment is to be implemented for the corresponding input signal.
An error value can be entered for the signals if a failure threshold has been defined for the
corresponding input in the window Timing — Analog Inputs. If the signal is below the failure
threshold, the timing is offset by the error value. The adjustment remains until the signal again
exceeds the threshold to reset the error state (see Timing — Analog Inputs on page 90).

Cylinder Individual Timing Limits

Enter the maximum possible cylinder individual offset. This setting limits, among other things, the
adjustment possibility in the window Cylinder Individual Offset. In addition the limits also apply to
the corresponding adjustment signals from all other sources, for example via the fieldbuses.

Speed Curve

The speed curve can be activated and disabled by mouse click and offsets the timing depending
on the speed. A max. of eight speed points are available. If you select a number of points from the
list, the corresponding number of fields is activated for input.

The first speed point is always set to 0 RPM. All other timing points are assigned with the value by
which the signal is to be offset when the respective speed is reached. For the last speed point, the
timing of the nominal speed should be entered. Please note that the speed points must always be
entered in ascending order.
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8.11.8 Timing — Schedule A/B — Energy

M unnamed.mic3® (MIC3+ 3x1.12) - MICT - ] x
Eile Device 3ettings Document Tools Help
A =g =2 Pl % P
JuEHSSES iR E0OA
Configuration Page Schedule A Energy Settings
- Eoe Start Phase
7 Parameters Speed Limit: 600 RPM
1 Cylinder Names Tne Linit: 5 5
L] tgnition Gutputs Startphase ends if both it are exceede.
| Ignition Coils
I Pickups Spark Duration: 300
~ [Timing Spark Intensity: 70
1| Analog Inputs P Voitaost 30
~ ] Schedule A e e
Energy Limit: 480 2 m
(Emited by nominal speed)
~
7 General [Rermal Opstation
Energy Spark Duration: 200 e s
| Miscellanecus Spark Intensity: 60 =] ma
~ [inputs/Outputs z
Max. Breakdown Voltage: 30
11 Alarms
L] Aso1 Energy Limit: 300
| Inputs
,,‘_"“""“S — Secondary iable if max, breakdown voltage is setin range 38 kV to 40 kv, Additionally it is
Communication y i required that the energy limit is set suffidently high.
Information Start phase: max. breakdown voltage out of range suitable for secondary diagnostics
Mormal oparation: max. breakdown voltage out of range suitable for sacondary diagnostics
Minimum required supply voltage for sustained operation:
Schedule A start phase: 15.0 V (at start phase speed limit)
Schedule A: 12.5V

@ COM4 IDMIC3+ 3x1.12 (1.10.1 [0000acO1]) ADV.SERVICE Full Access Version: 2.48.0

You can make different energy settings for the start phase and normal operation.

Start Phase

Set the start phase of your engine. To do this you can enter a Speed Limit, a Time Limit or both. If
you enter values for both criteria, both values must also be exceeded, so that the ignition
controller classifies the start phase as ended and sets the values for normal operation. If you only
want to use one criterion, set the other value to 0. If you do not want to define any start-up phase,
set both values to 0.

Enter values specific to your application for the Spark Duration, the Spark Intensity and the
Maximum Breakdown Voltage. The maximum breakdown voltage corresponds to the maximum
voltage expected during operation.

Normal Operation

If the criteria specified for the start phase are exceeded, the settings for normal operation are
used by the ignition controller. Make the energy settings the same as for the start phase.
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Energy Limit

You can use the field Energy Limit to limit the output energy made available by the ignition
controller. If the set output energy is no longer sufficient to reach the set energy values (spark
duration, spark intensity, max. breakdown voltage), the spark duration is reduced
correspondingly.

Required supply voltage for energy control

. Depending on the output configuration and the energy settings, for a
1 correct energy control, a higher supply voltage than the minimum 10 V DC
sufficient for operation of the device can be necessary. If this is the case,
NOTICE the required supply voltage is displayed in a notice in the window Timing

— Schedule A/B — Energy.

8.11.9 Timing — Miscellaneous

M unnamed.mic3” (MIC3= 3x1.12) - MICT - m] X

Eile Device 3ettings Document JTools Help
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[ asor
L1 Inputs
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S -
Communication

71 Information

@ COM4 IDMIC3+ 3x1.12 (1.10.1 [0000acO1]) ADV.SERVICE Full Access Version: 2.48.0
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You can specify how fast the changes of the timing should be executed.
— Maximum Firing Angle Change Per Cycle
Specify the maximum degrees per cycle that the ignition timing may be shifted by for both

directions, i.e. between two firings of a cylinder. If the specified ignition timing adjustment is
larger than the given value, it is divided among several cycles.

8.11.10 Inputs/Outputs — Alarms

M unnamed.mic3” (MIC3= 3x1.12) - MICT

= o X
Eile Device 3ettings Document JTools Help
- = = o [ W . a . e
JuEHSES %% OO0rA (¢
Configuration Page Alarms and GPO Settings
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Ignition Coils % unused Function: speed > threshold -
Pickops &: unused Threshold:  1000.0 ReM
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1 Analog Inputs 8 unused Hysteresis: 0.0  RPM
~ [ Schedule A 9: unused Delay: 0 ms
iy e 10: unused —
eneral
= 11: unused Settings
_ &l Energy 12: unused ]
~ [ Schedule B 13: unused () Engine Shutdown
) General 14: unused 8 Permanent - Keep output activated untl alarm is acknowedged
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1 Log Events
. Energy 16: unused 8
{7 Miscellaneous s
v Inputs/Outputs
eo1
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=
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v Miscellanecus
™ P~
Communication
7 Information
GPO Settings
GPOL: NORMALLY CLOSED ¥

@ COM4 1D MIC3+ 3x1.12 (1101 [0000ac01]) ADV.SERVICE Full Access Version: 2.48.0
The MIC3+ ignition controllers include a total of 16 configurable alarms that can be allocated to the
general purpose outputs.
— Description

You can enter any desired description for an alarm. The description is used for logging the
alarms that have occurred in the event list in the MICT.

Function

The alarms can be used depending on the following functions:

— Unused

— Speed above threshold/below threshold

— Engine operating hours above threshold/below threshold

— Spark plug operating hours above threshold/below threshold
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— Warning active

— Erroractive

— Temperature above threshold/below threshold

— Analog voltage input over threshold/under threshold

— Analog current input over threshold/under threshold

— Global ignition timing above the threshold/below the threshold

— Supply voltage above threshold/below threshold

— Min. spark duration above threshold/below threshold

— Misfire rate (primary, single output) over limit

— Misfire rate (primary, all outputs) over limit

— Misfires per second (primary, all outputs) above threshold

— Consecutive misfires (primary, single output) above threshold

— Misfire rate (secondary, individual output) above threshold

— Misfire rate (secondary, all outputs) above threshold

— Misfires per second (secondary, all outputs) above threshold

— Consecutive misfires (secondary, single output) over the limit
— Threshold

Input of desired threshold value.

— Hysteresis
Input of desired hysteresis value.

- Delay
Input of desired delay. The threshold value defined in the alarm must have been exceeded or
not reached for a longer period than the specified time for an alarm to be triggered. If a
corresponding value occurs for a shorter period of time, no alarm is triggered.

— Engine Shutdown
If this checkbox is checked, the ignition is switched off as soon as the alarm is triggered. The
shutdown causes an operational error. Therefore the checkbox should not be checked, if the
alarm Error active is selected.

— Permanent — Keep output activated until alarm is acknowledged
If this box is checked, the output remains permanently active until the alarm is acknowledged.
If the box is not checked, the output remains active only for as long as the alarm is active.

- Log Events
If this box is checked, the event list records when the alarm occurred or when it was
acknowledged.

—  Outputs
Activate the checkbox GPOT1, so that the general purpose output is activated when the alarm is
triggered.

- GPO Settings
Configure the general purpose output as normally closed or normally open.
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8.11.11 Inputs/Outputs — ASO1 (Auxiliary Synchronization Output)

M unnamed.mic3® (MIC3+ 3x1.12) - MICT - ] x

Eile Device 3ettings Document Tools Help
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& COM4 IDMIC3+ 3x1.12 (1.10.1 [0000ac01]) ADV.SERVICE Full Access Version: 2480

With the auxiliary synchronization output, freely definable impulses depending on the angle of the
crankshaft can be generated. For the output, the user defines whether the angle will be absolute
or based on the global timing. The output can generate between 1and 12 impulses and only be
assigned to one system at a time. One example of the application of the ASO output for a
detonation controller can be found in section ASO: Auxiliary Synchronization Output on page 57.

— No. of Points
Select the number of impulses from the No. of Points list. Please note that the DetCon
detonation controller devices require a single impulse with 200 pys synchronous with the first
cylinder in the ignition sequence. You can get this setting via the button Configure for
DetCon2/20.

— Angle Reference
Select from the Angle Reference drop-down list whether the angle shall be based on the
absolute angle of the crankshaft or the actual angle depending on global timing. Then, enter
the trigger angle for each impulse and the length of the impulse in ps. This setting also
determines when ASO signals are generated. For this, also read the information box ASO
signals depending on the ignition release.
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- Mode

Select the mode for the ASO signal.
In the default setting Trailing Rising Edge (default), the signal is low-active.

Level
>
t2 13
High — “—
- r »
*)
Low

°crankshaft

In the setting Trailing Falling Edge (inverted), the signal is high-active.

Level
ry

High

Low

A 4 !F A 4

“crankshaft

*) active edge marks the configured engine rotation angle

|

NOTICE

|

NOTICE

98

Maximum impulse duration

Please note that the duration of the impulse can be entered as max.
300 ps. Input of higher values will not be accepted by the system.

ASO signals depending on the ignition release

The setting in the drop down list Angle Reference determines when ASO
signals are generated:

— Actual Angles Depending on Global Timing
ASO pulses are only transmitted if ignition is active, indicated by the
green status display Firing Active in the window Runtime Data —
Overview.

— Absolute Timing
ASO pulses are generated independently of the ignition release as
soon as the synchronization of the pickups is accomplished.
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8.11.12 Inputs/Outputs — Inputs
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Various functions can be selected for the general purpose input GPI1:

Disabled
The input GPI1 will not be used.

CAN reset (1s pulse), device reset (5 s pulse)

This feature allows (e.g. a master control) to trigger a CAN reset and/or a device reset
externally using a high impulse. A high impulse of 1 second leads to a reset of the CAN driver
and a high impulse of 5 seconds leads to a device reset.

Warning acknowledge (< 3 s high), error and alarm acknowledge (> 3 s high), device reset
(> 15 s high)

This feature allows (e.g. a master control) warnings, errors, and alarms to be confirmed
and/or device reset to be triggered externally using a high impulse. If the high impulse is
shorter than 3 seconds, all warnings will be confirmed. If the high impulse is longer than
3 seconds, all errors and alarms will be confirmed. If the high level lasts for more than

15 seconds, this triggers a device reset.
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8.11.13 Miscellaneous — Communication
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CAN
Clicking on the CAN checkbox enables or disables the CAN interface on the device.

— ALL-IN-ONE (J1939)/J1939/CANopen
Select the desired protocol, depending on whether you want to set the communication for the

ALL-IN-ONE or for another device. For example, for a connection to the PowerView3, select
CANopen.

— J1939 Settings
The J1939 source address can be assigned between 0 and 253. Note that IDs cannot be
assigned more than once. The Address Filter can be used to set that broadcast PGNs are only
accepted from one or two specific source addresses you have entered. If the filter is
deactivated, the broadcast PGNs are accepted from all source addresses.

— CANopen Settings
The CANopen node ID can be assigned between 1and 127. Note that IDs cannot be assigned
more than once.

— Baudrate
Select the desired data transfer rate from the list. The baud rate can be defined between
50 kbit/s and 1 Mbit/s, the recommended value being 250 kbit/s.
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RS485
Clicking on the field RS485 enables or disables the Modbus interface on the device.

Baudrate
Select the desired data transfer rate from the list. The Modbus baud rate can be defined
between 9,600 bit/s and 115,200 bit/s, the recommended value being 19,200 bit/s.

Parity
Define if a parity bit is used and if the parity is to be even or odd.

Stopbits

Determine if one or two stop bits are to be sent. Two stop bits can only be sent if no parity has

been selected.

Modbus Address

The Modbus address can be assigned between 1and 247. Note that IDs cannot be assigned
more than once.

Mode

Define if the data are transferred in the ASCIl or RTU mode.

Setting the transfer rate

Note that all devices connected with a bus must be set to the same

1 transfer rate.

NOTICE

Information on protocols

-4 Please contact your MOTORTECH contact person if you require more
1 information on the CANopen®, J1939 and Modbus protocols.
NOTICE

Rev. 01/2026
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8.11.14 Miscellaneous — Information
This configuration page can be viewed by all users, but changes can only be made with

authorization for the Service access level.

M unnamed.mic3” (MIC3= 3x1.12) - MICT

Eile Device 3ettings Document Tools
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[ Communication
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Help
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Module
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& COM4 IDMIC3+ 3x1.12 (1.10.1 [0000acO1]) ADV.SERVICE Full Access Version: 2.48.0 4

In this section, enter information on the system and the module for which the configuration will be

used.

Service Contact

In this section, individual contact data can be saved that can be called up and displayed via MICT.
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8.12 Runtime Data
— Click on the symbol to open the window Runtime Data. The following sections will
give you an overview of the data you can view on the individual tabs.

You can print and record the runtime data. For this purpose, the following functions are at your
disposal in the toolbar in the window:

Symbol Function
Prints the runtime data.

Prints the runtime data to a PDF file.

Opens the print preview.

Y Starts the runtime data trace.
> Stops the runtime data trace.
i |
..\1;‘ Acknowledges operational errors. If an operational error is acknowledged, all
‘ QO'; 7 alarms are also simultaneously acknowledged. The symbol is grayed out if no

acknowledgeable error is present.

Save runtime data locally

[ ] )
You should always save runtime data on the local computer and not on a

network drive or an external storage device. Trace files can only be
moved freely once the recording is stopped.

|

NOTICE
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8.12.1 Runtime Data — Overview

M MICT - Runtime Data - [m] x
5P 5% 4 e = T
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Q Wait for Stop J Start Phase
) Waming @ Alarm
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Control
Q Firing Enabled
QD Schedule A
@ cPi
Speed - RPM
Qutput
@ GPO1
Failure
@ Analog Current Input (D Analog Voltage Input
@ Ignition Qutput
Timing Misfire Rate
Global Timing Point [l eToc Primary Secondary
Single Output - % - %
Operating Hours
i o ISR < NN
park Puugs RN
s s
engine. |G - o

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01]) Lifetime: 0:12:04.500

You can find the following information in the window:
— Speed Indicator (analog)

— Red pointer
Displays the current registered speed

- Yellow pointer
Displays the maximum registered speed since last starting the engine

— Green pointer
Display of set overspeed
— Speed Indicator (digital)
Digitally displays the current speed

— Global Timing Point
Digital indication of the current global timing
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— Operating Hours
— Spark Plugs
Indicates the current operating hours of the spark plugs
- Engine
Indication of current operating hours of the engine
— Device State
The status of the device is shown by the following status displays:

Device status Description

Idle The ignition is ready and waiting for pickup activity.

Synchronizing Pickup signals are being received and analyzed.

Firing Active The ignition is active.

Firing Locked Pickup signals are being received and are valid, ignition is not
released.

Wait for Stop Pickup signals are being received, the ignition fired above the

security speed, and the ignition release was retracted. The
engine must now come to a standstill.

Configuration The device is being configured.

Self Test The self test is running (refer to Self Test on page 67).

Start Phase The engine is in the configured start phase (refer to section
Timing — Schedule A/B — Energy on page 93).

Warning A warning has occurred (see section Warnings on page 120).

Error An error has occurred (see section Errors on page 121).

Alarm A configured alarm has occurred (see section Alarms on
page 121).

— Control

— Firing Enabled
The green status display signals that the firing is active.

— Schedule A/B
The green status display shows which parameter settings are currently used.

'(I%E:status display shows the status of the input signal.
— Output
- GPO1
The general purpose output is switched on with the green status display.
— Failure

— Analog Current Input
The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again gray.
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106

Analog Voltage Input

The red status display signals that the set failure threshold for the input has been
reached. If the lower limit of the signal is reached again, the status display is again gray.
Ignition Output

The red status display signals a current misfire on at least one output. With a yellow

status display at least one misfire has occurred at one output since the last reset of the
counter.

Misfire Rate

The misfire rate is displayed for the primary side and secondary side. The misfire rate on the
secondary side is only displayed if the secondary side diagnosis is activated (refer to section
Engine — Ignition Coils on page 84).

Single Output
Displays the misfire rate of the output for which the most misfires were registered during
the last 32 cycles.

All Outputs
Displays the misfire rate for all the ignition outputs for the past 32 cycles.

The number of misfires per second are calculated by the MIC3+ as follows:
2-stroke engine: Number of currently misfiring outputs x RPM / 60
4-stroke engine: Number of currently misfiring outputs x RPM /60 / 2
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8.12.2 Runtime Data — Timing
B! MICT - Runtime Data

= o

Lo SUNCIRC

Overview  Timing  Ignition BankA  States  Messagelog  Diagnostics  Temperatwes  Information

Global Timing Point Calculation

Base Timing + [JEMI 5T0C

Potentiometer Timing  + - RET - % l_'_r_'_T_'_‘_'_]_‘_‘

Analog Current Input Tiwing + [ ENEN ~ov DG .
o 5 10 15 2
Analog Voltage Input Timing + - RET _ " P

Speed Curve Correction + - RET

Timing Correction  + - RET
Global Timing Point  [JEN s1oc
Indvidual Timing
minimum [N sTOC

Maximum - BTDC
Average - BTDC

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01]) Lifetime: 0:16:51.000

In this view, the system displays all values and settings in the left hand section that influence the
timing. On the right, the current input values (e. g. potentiometer, analog current and voltage
input), leading to the displayed timing adjustment, are displayed numerically and in bar charts. The
value for the speed curve is shown by curve progression set in the configuration. Refer to the
section Timing — Schedule A/B — General on page 91. The timing correction can be implemented
for the runtime. Refer to the section Runtime Adjustments — Timing on page 131.

In the lower range, the maximum, minimum and average of the cylinder individual offsets are also
displayed.
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8.12.3 Runtime Data - Ignition
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Coll Data Version: 1

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01]) Lifetime: 1:23:54.500

The following information is provided:

—  Column: Output
Designation of the output

— Column: Cylinder
If cylinder names are assigned, these are displayed.

— Column: Estimated Secondary Voltage [kV]
Secondary voltage determined by the ignition controller of the respective output.
The secondary voltage is used to determine deviations between the individual outputs. These
indicate a possible problem at this output (e. g. problems in the area of the spark plug or the
cylinder).
If you have set the ignition coils (refer to Engine — Ignition Coils on page 84) for which a
secondary voltage estimate does not seem possible "---" appears.
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—  Column: Misfire
The red status display signals a current misfire at the respective output. With a yellow status
display at least one misfire has occurred at the respective output since the last reset of the
counter.

The coil data version configured in the MIC3+ is displayed under the ignition runtime data.

8.12.4 Runtime Data — Bank A

M MICT - Runtime Data - [m] %

FHH G

Overview  Tming Igniion BankA  States Messagelog D e

. Misfire
Qutput Cylinder [.Eg;:k] DMuj:';.tinSr?a[:;] OIE:E{?W] Primary Secondary
open short Rate [%] open short Rate [%)

~ sHEE EESE EE o ol o o
2 +EEE EESE B o o lH o o R
w~ il i El o o HE o o
~ il S EE o o o o Hl
» ISl HEEE EE o ol o o
» N EEE EE o ol o o
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o NN EEE EE o o HH o o

Show Firing Angles: @ Relative (O Absolute

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01]) Lifetime: 1:30:53.000

The following information is provided:

—  Column: Output
Designation of the output

—  Column: Cylinder
If cylinder names are assigned, these are displayed.

— Column: Angle
Current output firing angle

—  Column: Min. Spark Duration
Minimum spark duration of the outputs
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— Column: Energy Output
Current energy release of the output

— Columns: Misfire
Status display for the different types of misfires (primary, secondary, open, short circuit). In
case of misfire, the respective status display turns red, otherwise it is gray. With a yellow
status display misfires have occurred since the last reset of the counter.
If you hold the pointer over the status display, an overview of the misfire counter of the
respective output is displayed for all types of misfires. A maximum up to 255 is counted per
type of misfire. The counter manually resets using the menu item Device-> Send command ->
Reset misfire counters. When starting the engine and starting the self test the counters are
automatically reset.

You have the following options:

— Relative/Absolute
Select via the option, whether the firing angle should be displayed absolute or relative.

8.12.5 Runtime Data — States

M MICT - Runtime Data - [m] X

FRH G

Overview Timing Ignition Bank A States Message Log Diagnostics ~ Temperatures Information

Operating Hours  Time Status Message
50:11:27.848  2021-07-14 10:36:39 PU1: Operational error.
50:11:27.848  2021-07-14 10:36:39 PUT: Number of events (5) counted on pickup input PU1 does not match

& COMS5 ID MIC3+ 3x1.12 (1.10.1 [0000acO1))  Lifetime: 50:11:36.979 ¢
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Status messages are listed in the States view.

The following information is provided:

Operating Hours

Operating hours counter reading at the time of message

Time

Date and time of the message (see following information box)

Status Message
Message text

1

NOTICE

Date and time of ignition controller

The date and time can be individually configured for each ignition
controller and saved in the device. The device does not adjust
automatically for daylight savings time. Hence, deviations may occur
between the device time and the time settings of the computer used for
accessing the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the
ignition controller is shown in the view Runtime Data — Information. You
can adjust the time of the ignition controller by entering the desired time

in the menu via Device -> Set date and time.

Status messages are displayed in black if they are current. If a status is reset, the status message
is displayed gray for 10 seconds before it is deleted from the list.

The following status messages can be displayed:

Status message

Alarm shutdown caused by alarm
number.

Analog current input failure
(current: x mA, failure threshold:
y mA, failure reset threshold:
zZmA).

Analog voltage input failure
(voltage: x V, failure threshold: y V,
failure reset threshold: z V).

Aux analog input supply voltage
failure (voltage: u V, desired
voltage: v V, failure threshold: x V,
failure reset threshold: y V).

Rev. 01/2026

Description

The engine was shut down by an alarm, as the configured
limit was exceeded or not reached. You can view the alarm
number in the configuration (see Inputs/Outputs — Alarms
on page 95).

Failure threshold set for analog current input was
undershot (see Timing — Analog Inputs on page 90).

The following values were obtained: Current: x mA, failure
threshold: y mA, threshold for failure reset: z mA.

Failure threshold set for analog voltage input was
undershot (see Timing — Analog Inputs on page 90).
The following values were obtained: Voltage: x V, failure
threshold: y V, threshold for failure reset: z V.

Error in auxiliary supply voltage of analog inputs (see
Timing — Analog Inputs on page 90). The following values
were obtained: Voltage: u V, expected voltage: v V, failure
threshold: x V, threshold for failure reset: y V

m
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Status message

Aux pickup supply voltage failure
(voltage: u V, desired voltage: v V,
failure threshold: x V, failure reset
threshold: y V).

Configuration data checksum
error. Using default configuration.

Configuration invalid. Using
previous configuration.

Current sensor of output bank
name failed.

Cylinder individual timing limited to

range timing 1.. timing 2

Device started after supply voltage

failure.

General error number.

Global timing x° crankshaft limited
to range y° crankshaft .. z°
crankshaft.

Incompatible coil parameters
received, secondary voltage
diagnostics disabled.

Output board identification failed
due to a checksum error.

Output board identification failed
due to incompatible hardware.

Output board identification failed
due to missing data.

12

Description

Error in auxiliary supply voltage of pickup (see Engine —
Pickups on page 86). The following values were obtained:
Voltage: u V, expected voltage: v V, failure threshold: x V,
threshold for failure reset: y V

The checksum of the configuration data is faulty. The
default configuration is used. This message may appear
during an upgrade/downgrade. Check your configuration
data and the MICT version being used. Then download the
configuration to the device again.

The configuration is invalid. The previous configuration is
used. This message may appear during an upgrade/
downgrade. Check your configuration data and the MICT
version being used. Then download the configuration to
the device again.

The current sensor of output bank name failed. Restart the
device. If the error occurs again after restarting the device,
please contact MOTORTECH.

The cylinder-individual offset has reached the set limit
(Timing 1... Timing 2 (see Timing — Schedule A/B — General
on page 91).

The device was started after a failure of the supply
voltage. If applicable, check the power supply to the
device.

General error number. Restart the device. If the error
occurs again after restarting the device, please contact
MOTORTECH.

The global timing (x° crankshaft) is located outside the
configured limits (y° crankshaft .. z° crankshaft; see Timing
— Schedule A/B — General on page 91).

Incompatible coil parameters received. The secondary
voltage diagnostics have been disabled. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device again.

The identification of the output board failed due to a
checksum error. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
incompatible hardware. Restart the device. If the error
occurs again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to missing
data. Restart the device. If the error occurs again after
restarting the device, please contact MOTORTECH.
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Status message

Output board identification failed
due to unknown error number.

Output board identification failed
due to unknown hardware.

Pickup configuration invalid.

Power failure detected on output
Anumber.

Power output (x W) exceeded error
threshold limit (y W) at a supply
voltage of z V.

Power output (x W) exceeded limit
(y W) at a supply voltage of z V.

The power output (x W) exceeded
permanent limit (y W) at a supply
voltage of z V.

PUnumber: Faulty index.

PUnumber: Faulty Signal. Signal
period (x, events counted y) is too
small compared to previous signal
period (2).

Rev. 01/2026

Description

The identification of the output board failed due to
unknown error number. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
unknown hardware. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The pickup configuration is invalid. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device again.

Power supply fault in output board caused by output
Anumber. Restart the device. If the error occurs again
after restarting the device, please contact MOTORTECH.

The power output (x W) exceeded failure threshold (y W) at
a supply voltage of z V. Increase the supply voltage and
check the energy settings (see Timing — Schedule A/B —
Energy on page 93).

The power output (x W) exceeded warning threshold limit
(y W) for longer than two minutes at a supply voltage of z V
. Increase the supply voltage and check the energy
settings (see Timing — Schedule A/B — Energy on page 93).

The power output (x W) exceeded warning threshold limit
(y W) for longer than three minutes at a supply voltage of

z V. Increase the supply voltage and check the energy
settings (see Timing — Schedule A/B — Energy on page 93).

The pickup PUnumber has an error in index. Check the
pickups and the corresponding configuration (see Engine
— Pickups on page 86). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 149.

The pickup (PUnumber) is supplying a faulty signal. Signal
period (x, events counted y) is too small compared to
previous signal period (z). Check the pickups and the
corresponding configuration (see Engine — Pickups on
page 86). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 149.

13
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Status message

PUnumber: Index mark missing.

PUnumber: Missing index.

PUnumber: Missing Signal. Signal
period (x, events counted y) is too
great compared to previous signal
period (2).

PUnumber: Missing Signal. Signal
timeout occurred (events counted
X).

PUnumber: No index mark found.

PUnumber: No signal.

PUnumber: Number of events (x)
counted on pickup input
PUnumber does not the match the
expected value (y).

PUnumber: Operational error.

14

Description

Index mark missing for pickup (PUnumber). Check the
pickups and the corresponding configuration (see Engine
— Pickups on page 86). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 149.

Index missing for pickup (PUnumber). Check the pickups
and the corresponding configuration (see Engine —
Pickups on page 86). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 149.

Signal missing for pickup (PUnumber). Signal period (x,
events counted y) is too large compared to previous signal
period (z). Check the pickups and the corresponding
configuration (see Engine — Pickups on page 86).
Furthermore, also pay attention to the instructions in the
section entitled Pickup Input Errors on page 149.

Signal missing for pickup (PUnumber). Timeout occurred
(events counted until timeout x). Check the pickups and
the corresponding configuration (see Engine — Pickups on
page 86). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 149.

Could not find index mark for pickup (PUnumber). Check
the pickups and the corresponding configuration (see
Engine — Pickups on page 86). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 149.

The pickup (PUnumber) is not supplying a signal. Check
the pickups and the corresponding configuration (see
Engine — Pickups on page 86). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 149.

For the pickup (PUnumber) the number of events (x)
counted on pickup input number does not the match the
expected value (y). Check the pickups and the
corresponding configuration (see Engine — Pickups on
page 86). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 149.

An operational error occurred at pickup (PUnumber).
Check the pickups and the corresponding configuration
(see Engine — Pickups on page 86). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 149.
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Status message

PUnumber: Polarity detection
failed.

PUnumber: Synchronization
problem.

PUnumber: Wrong pickup signal
polarity on pickup input PUnumber
detected. Reversing polarity
internally.

Self test aborted because pickup
signals have been detected on
pickup input PUnumber.

Speed (x RPM) exceeded
overspeed limit (y RPM) at trigger
signal number.

Temperature of device (x °C)
exceeded error threshold limit
(y °C).

Temperature of device (x °C)
exceeded limit (y °C).

Temperature of device (x °C)
exceeded permanent limit (y °C).

Temperature sensor failed.

Rev. 01/2026

Description

Polarity detection failed for pickup (PUnumber). Check the
pickups and the corresponding configuration (see Engine
— Pickups on page 86). Furthermore, also pay attention to
the instructions in the section entitled Pickup Input Errors
on page 149.

A synchronization error occurred at pickup (PUnumber).
Check the pickups and the corresponding configuration
(see Engine — Pickups on page 86). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 149.

Wrong polarity of pickup (PUnumber) detected at pickup
input PUnumber. Reversing polarity internally. No
additional action required.

Self test aborted because pickup signals have been
detected on pickup input PUnumber. Self test can only be
carried out when engine is at a standstill (see Self Test on
page 67).

Potential causes:

— Interference coupling on pickup signal
— Engine was started

The speed (x RPM) exceeded overspeed limit (y RPM) at

trigger signal number (see Engine — Pickups on page 86).
The reason for this may also be an interference coupling

on the trigger signal.

The temperature of the device (x °C) exceeded the failure
threshold (y °C). Ensure that there is sufficient air
circulation and/or cooling.

The temperature of the device (x °C) exceeded the
warning threshold limit (y °C) for more than two minutes.
Ensure that there is sufficient air circulation and/or
cooling.

The temperature of the device (x °C) exceeded the
warning threshold limit (y °C) for more than ten minutes.
Ensure that there is sufficient air circulation and/or
cooling.

The temperature sensor has failed. Restart the device. If
the error occurs again after restarting the device, please
contact MOTORTECH.

15



8 Settings via the MICT

8.12.6 Runtime Data — Message Log

M MICT - Runtime Data - [m] X
— e N oy
= - sy

AR SR V)

Overview  Timing Igniton  BankA  States  Messagelog  Diagnostics  Temperatwes  Information

<

Operating Hours  Time Category Message n

43:51:27.974  2021-07-06 09:10:50 Infe 11939 on interface CANT changed state to "Enter”.
43:51:28.234  2021-07-06 09:10:51 Info 11939 on interface CAN1T changed state to "Rtart succeeded
43:56:03.913  2021-07-06 0%:15:26  Info  Configuration changed.

43:56:03.916  2021-07-06 02:15:26  Alarm  All alarms reset.

44:41:41.210  2021-07-06 10:01:04  Info  Device switched off.

44:41:42.473  2021-07-06 10:33:10  Info  Device (firmware 1.12.0.40630) started at a supply voltage o
44:41:42.474  2021-07-06 10:33:10 Infe  J1939 on interface CAN1 changed state to "Enter”.
44:41:42.734  2021-07-06 10: Info  J1939 on interface CANT changed state to "tart succeeded
46:22:38.642  2021-07-06 Info  Device switched off.

46:22:39.905  2021-07-07 Info  Device (firmware 1.12.0.40630) started at a supply voltage o
46:22:39.906  2021-07-07 Infe  J1939 on interface CANT changed state to "Enter”.
46:22:40.166  2021-07-07 Info 11939 on interface CAN1 changed state to "Start succeeded
46:40:10.416  2021-07-07 Info  Device switched off.

46:40:11.679  2021-07-07 Info  Device (firmware 1.12.0.40630) started at a supply voltage o
46:40:11.680  2021-07-07 09:34:29 Info  J1939 on interface CANT changed state to "Enter”.
46:40:11.940  2021-07-07 09:34:29  Info 11939 on interface CAN1T changed state to “Start succeeded
47:37:20.339  2021-07-07 10:31:38 Infe  Device switched off.

4T:37:21.602 2021-07-13 10:10:32  Info  Device (firmware 1.12.0.40630) started at a supply voltage o
47:37:21.603  2021-07-13 10:10:32 Info 11939 on interface CAN1 changed state to "Enter”,
47:37:21.863  2021-07-13 10:10:32  Info  J1939 on interface CAN1T changed state to “Start succeeded
49:11:15.930  2021-07-13 11 Infe  Self test started.

49:11:39.794  2021-07-13 11:44: Infe  Self test stopped.

49:35:45.848  2021-07-13 12:08:57  Info  Device switched off.

49:35:47.112  2021-07-14 10:00:38  Info  Device (firmware 1.12.0.40630) started at a supply voltage o
49:33:47.112 2021-07-14 10:00:58  Info  J1939 on interface CAN1 changed state to “Enter”.
49:35:47.373  2021-07-14 Infe  J1939 on interface CAN1T changed state to "Rart succeeded
50:08:54.525 2021-07-14 Info  Firing disabled (Start/Step In: disabled, CAM: n/a, RS485: n/.
50:09:55.029 2021-07-14 : Info  Firing enabled (Start/Stop In: enabled, CAN: nfa, R$485: n/a
50:11:27.842  2021-07-14 10:36:39  Error  General error in pickup pre-processing on pickup input PU”
50:11:27.848 2021-07-14 10:36:39  Error  Qperational error caused by pickup signals. PUT = (x00010(
50:12:48.254  2021-07-14 10:37:59 Info  Operational error acknewledged.

>

Automatic scrolling Adknowledge Alarms.

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01]) Lifetime: 50:12:59.979

In the view Message Log, information, warnings, errors and alarms are listed.

Information, warnings and errors are specified by the ignition controller, while alarms can be
freely configured using the MICT. Refer to the section Inputs/Outputs — Alarms on page 95.

Errors and appropriately configured alarms shut down the engine.

The following information is provided:

116

Operating Hours
Operating hours counter reading at the time of message

Time
Date and time of the message (see following information box)

Category
Type of message (information, warning, error, alarm)

Message
Message text; you can find more information on the message texts in the following sections.
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You have the following options:

— Automatic scrolling
If this box is checked, the system automatically displays the last list entry until a new event

occurs.

— Acknowledge Alarms
With this button, you can reset triggered alarms if they are no longer active. An alarm can only
be acknowledged if the checkbox Permanent — Keep output activated until alarm is
acknowledged in the alarm configuration is activated.

1

NOTICE

1

NOTICE

Date and time of ignition controller

The date and time can be individually configured for each ignition
controller and saved in the device. The device does not adjust
automatically for daylight savings time. Hence, deviations may occur
between the device time and the time settings of the computer used for
accessing the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the
ignition controller is shown in the view Runtime Data — Information. You
can adjust the time of the ignition controller by entering the desired time
in the menu via Device -> Set date and time.

Acknowledging an operational error

While the engine is in standstill, there are the following options for
acknowledging operational errors:

Via Device -> Send Command -> Acknowledge Operational Error in
the MICT

Restart / Reset

8.12.6.1 Information

Information Description

Access control disabled. The Access control was disabled (see Access Control for
MIC3+ on page 71).

Access control enabled. The Access control was enabled (see Access Control for
MIC3+ on page 71).

All access control PINs reset. All PINs for access control were reset (see Access Control

for MIC3+ on page 71).

CAN interface CANnumber entered The CAN interface CANnumber has entered Bus off state

bus off state.

Rev. 01/2026

(see Runtime Data — Diagnostics on page 124).
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Information

CAN interface CANnumber left bus
off state.

CAN reset requested by
GPlnumber.

CANopen on interface CANnumber
changed state to "name".

Configuration changed.

Date and time set.

Device (firmware
number.number.number.number)
started at a supply voltage of x V.

Device reset requested by
GPlnumber failed because pickup
signals have been detected.

Device switched off.
Engine operating hours set to x h.

Failed to change PIN of access
control level "number".

Failed to disable access control.
Failed to enable access control.
Failed to reset all access control

PINs.

Firing disabled (Start/Stop In:
value, CAN: value, RS485: value)

Firing enabled (Start/Stop In: value,
CAN: value, RS485: value)

118

Description

The CAN interface CANnumber has left the Bus off state
(see Runtime Data — Diagnostics on page 124).

A CAN reset was requested via general purpose input
GPInumber (see Inputs/Outputs — Inputs on page 99).

The CANopen at interface CANnumber has changed state
to "name" (state of NMT State Machine according to CiA
DS 301).

The configuration of the device was changed (via MICT or
via fieldbus).

The date and the time have been set.

The device (firmware number.number.number.number)
was started with a supply voltage of x V.

The device reset requested by GPlnumber failed because
pickup signals have been detected (see Inputs/Outputs —
Inputs on page 99).

The device was switched off.
The engine operating hours set to x h.

Failed to change PIN of access control level "number" (see
Access Control for MIC3+ on page 71).

The access control could not be disabled (see Access
Control for MIC3+ on page 71).

The access control could not be enabled (see Access
Control for MIC3+ on page 71).

Failed to reset all PINs for access control (see Access
Control for MIC3+ on page 71).

The firing is disabled, because at least one of the inputs
(start/stop input, CAN interface, RS485 interface) used for
the firing release is disabled. The inputs can have the
following values:

— enabled: Firing enabled
— disabled: Firing disabled
— n/a:not used

The firing is enabled, because all inputs (start/stop input,
CAN interface, RS485 interface) used for the firing release
are enabled. The inputs can have the following values:

— enabled: Firing enabled
— disabled: Firing disabled
— n/a:not used
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Information

J1939 on interface CANnumber
changed state to "name".

One or more messages are lost due
to exhausted memory pool or
message queue overrun.

Operational error acknowledged.

PIN of access control level
"number" changed.

Self test denied because no
outputs are configured.

Self test started.
Self test stopped.

Spark plug operating hours set to
X h.

Speed (x RPM) exceeded maximum
allowed speed (yRPM) at power-
on. Waiting for engine stop.

Wrong pickup signal polarity on
pickup input PUnumber detected.
Reversing polarity internally.

Rev. 01/2026

Description

J1939 on interface CANnumber changed state to "name".

Following statuses are possible:

— Enter/Start succeeded
The CAN mode J1939 or ALL-IN-ONE (J1939) was
started.

—  Start failed
Initialization failed.

- Stop
Assignment of the Source Address was unsuccessful.
A different source address needs to be set in the
configuration (see Miscellaneous — Communication on
page 100).

- Leave
Left CAN mode J1939 or ALL-IN-ONE (J1939).

One or more messages were lost because there was
insufficient storage space or too many messages were
queued.

Operational errors are acknowledged.

PIN of access control level "number" changed (see Access
Control for MIC3+ on page 71).

The self test could not be carried out because no outputs
are configured (see Self Test on page 67).

The self test was started (see Self Test on page 67).
The self test was stopped (see Self Test on page 67).

The spark plug operating hours were set to x h.

Speed (x RPM) has exceeded the maximum speed (y RPM)
during operation. The ignition controller is waiting for the
engine to stop.

Wrong pickup polarity detected at pickup input PUnumber.
Reversing polarity internally.
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8.12.6.2 Warnings

Contrary to errors, warnings do not result in the engine being shut down.

Warning

Configuration data checksum error.
Using default configuration.

Configuration invalid. Using
previous configuration.

Disable secondary diagnostic due
to output Anumber.

General warning number.

Incompatible coil parameters
received, secondary voltage
diagnostics disabled.

Invalid coil data received.

Pickup configuration invalid.

Power output (x W) exceeded limit
(y W) at a supply voltage of z V.

Speed (x RPM) exceeded
overspeed limit (y RPM). Previous
speed was z RPM.

Temperature of device (x °C)
exceeded limit (y °C)

120

Description

The checksum of the configuration data is faulty. The
default configuration is used. This message may appear
during an upgrade/downgrade of the firmware. Check your
configuration data and the MICT version being used. Then
download the configuration to the device again.

The configuration is invalid. The previous configuration is
used. This message may appear during an upgrade/
downgrade. Check your configuration data and the MICT
version being used. Then download the configuration to
the device again.

Secondary diagnosis disabled due to output Anumber shut
off. Check the ignition coil and wiring at the corresponding
output.

General warning number. An undefined warning has
occurred. If this occurs repeatedly, please contact
MOTORTECH.

Incompatible coil parameters received. The secondary
voltage diagnostics have been disabled. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device again.

Invalid coil data received. This message may appear during
an upgrade/downgrade. Check your configuration data and
the MICT version being used. Then download the
configuration to the device again.

The pickup configuration is invalid. This message may
appear during an upgrade/downgrade. Check your
configuration data and the MICT version being used. Then
download the configuration to the device again.

The power output (x W) exceeded warning threshold limit
(y W) for longer than two minutes at a supply voltage of z V

Speed (x RPM) exceeded overspeed limit (y RPM).
Previous speed was z RPM (see Engine — Pickups on page
86). The reason for this may also be an interference
coupling on the trigger signal.

The temperature of the device (x °C) exceeded warning
threshold limit (y °C) for more than two minutes. Ensure
that there is sufficient air circulation and/or cooling.
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8.12.6.3 Alarms

Alarms can be defined in the configuration. When doing so, each alarm is assigned a number (see

Inputs/Outputs — Alarms on page 95).

Alarm

Alarm number "description"
acknowledged.

Alarm number "description"
triggered.

All alarms reset.

8.12.6.4 Errors

Description

The alarm number "description" was acknowledged.

The alarm number "description" was triggered.

All alarms reset.

All system or operational errors cause the engine to be shut down.

Error
Alarm shutdown caused by alarm
number.

Assertion failed (x).

Critical error x (y).

Current sensor of output bank
name failed.

Cycle signal was missing, so more
trigger signals were counted than
available per cycle.

Device started after supply voltage
failure.

General error number.

General error in pickup pre-
processing on pickup input
PUnumber.

Rev. 01/2026

Description

The engine was shut down by alarm number. This function
was defined in the configuration (see Inputs/Outputs —
Alarms on page 95).

An assertion was not adhered to (x). For example, an
assumption about a value was not fulfilled in the firmware.
If the error occurs again after restarting the device, please
contact MOTORTECH.

Critical error x (y). If the error occurs again after restarting
the device, please contact MOTORTECH.

The current sensor of output bank name failed. Restart the
device. If the error occurs again after restarting the device,
please contact MOTORTECH.

Cycle signal was missing, so more trigger signals were
counted than available per cycle. Check the pickups and
the corresponding configuration (see Engine — Pickups on
page 86). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 149.

The device was started after a failure of the supply
voltage. If applicable, check the power supply to the
device.

General error number. An undefined error has occurred.
Restart the device. If the error occurs again after restarting
the device, please contact MOTORTECH.

General error in pickup pre-processing on pickup input
PUnumber. Check the pickups and the corresponding
configuration (see Engine — Pickups on page 86).
Furthermore, also pay attention to the instructions in the
section entitled Pickup Input Errors on page 149.
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Error

Number of trigger signals (number)
counted does not match the
configured value.

Operational error caused by pickup
signals. PU1=x, PU2=y.

Output board identification failed
due to a checksum error.

Output board identification failed
due to incompatible hardware.

Output board identification failed
due to missing data.

Output board identification failed
due to unknown error number.

Output board identification failed
due to unknown hardware.

Power failure detected on output
Anumber.

Power output (x W) exceeded error
threshold limit (y W) at a supply
voltage of z V.

122

Description

Number of trigger signals (number) counted does not
match the configured value. Check the pickups and the
corresponding configuration (see Engine — Pickups on
page 86). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 149.

An operational error was caused by pickup signals (pickup
PU1 = x, pickup PU2 = y).

For information on the numbers shown, please consult the
documentation on the pickup status bits on the storage

device enclosed with the ignition controller. You can open
the file via the menu: Documentation -> More information.

Check the pickups and the corresponding configuration
(see Engine — Pickups on page 86). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 149.

The identification of the output board failed due to a
checksum error. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
incompatible hardware. Restart the device. If the error
occurs again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to missing
data. Restart the device. If the error occurs again after
restarting the device, please contact MOTORTECH.

The identification of the output board failed due to
unknown error number. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

The identification of the output board failed due to
unknown hardware. Characteristic data of the output
board could not be read, they are defective or do not
match the device. Restart the device. If the error occurs
again after restarting the device, please contact
MOTORTECH.

Power supply fault in output board caused by output
Anumber. Restart the device. If the error occurs again
after restarting the device, please contact MOTORTECH.

The power output (x W) exceeded failure threshold (y W) at
a supply voltage of z V.
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Error

Power output (x W) exceeded
permanent limit (y W) at a supply
voltage of z V.

Self test aborted because pickup
signals have been detected on
pickup input PUnumber.

Speed (x RPM) exceeded
overspeed limit (y RPM) at trigger
signal number.

Supply voltage failure.

Temperature of controller board
(x °C) exceeded limit (y °C).

Temperature of device (x °C)
exceeded error threshold limit
(y °C).

Temperature of device (x °C)
exceeded permanent limit (y °C).

Temperature of output board (x °C)
exceeded limit (y °C).

Temperature sensor of controller
board failed.

Temperature sensor of output
board failed.

Rev. 01/2026

Description

The power output (x W) exceeded warning threshold limit
(y W) for longer than three minutes at a supply voltage of
zV.

Self test aborted because pickup signals have been
detected on pickup input PUnumber. Self test can only be
carried out when engine is at a standstill (see Self Test on
page 67).

Potential causes:

— Interference coupling on pickup signal

- Engine was started

The speed (x RPM) exceeded overspeed limit (y RPM) at
trigger signal number (see Engine — Pickups on page 86).
The reason for this may also be an interference coupling
on the trigger signal.

Supply voltage failure. If applicable, check the power
supply to the device.

The temperature of controller board (x °C) exceeded limit
(y° C). Ensure that there is sufficient air circulation and/or
cooling.

The temperature of the device (x °C) has exceeded the
failure threshold (y °C). Ensure that there is sufficient air
circulation and/or cooling.

The temperature of the device (x °C) has exceeded the
warning threshold limit (y °C) for more than two minutes.
Ensure that there is sufficient air circulation and/or
cooling.

The temperature of output board (x °C) exceeded limit
(y °C). Ensure that there is sufficient air circulation and/or
cooling.

The temperature sensor of controller board failed. Restart
the device. If the error occurs again after restarting the
device, please contact MOTORTECH.

The temperature sensor of output board failed. Restart the
device. If the error occurs again after restarting the device,
please contact MOTORTECH.
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Error

Trigger period (x, triggers counted
y) is not in acceptable range
compared to previous trigger
period (2).

Trigger signal missing. Current
trigger period (triggers counted x)
is out of the specified range related
to the previous trigger period.

Description

The trigger period (x, triggers counted y) is not in
acceptable range compared to previous trigger period ().
Check the pickups and the corresponding configuration
(see Engine — Pickups on page 86). Furthermore, also pay
attention to the instructions in the section entitled Pickup
Input Errors on page 149.

The trigger signal is missing. Current trigger period
(triggers counted x) is out of the specified range compared
to the previous trigger period. Check the pickups and the
corresponding configuration (see Engine — Pickups on
page 86). Furthermore, also pay attention to the
instructions in the section entitled Pickup Input Errors on
page 149.

8.12.7 Runtime Data — Diagnostics

E‘-é MICT - Runtime Data

FHA B

Overview  Tming Igniion BankA  States
CAN State

) Error Active
Voltages

Supply Voltage [V]
- I

0 10 20 30 0

) Ermor Passive

Pickup Input 1 Pre-Trigger [V]

L _m——

0 2 4 L] 8 0
Pickup Input 2 Pre-Trigger [V]

-

0 2 4 6 8 10

Message Log Diagnostics

Temperatwres  Information

) Bus OF

Aux Pickup Supply Voltage [V]
- N
0 5 10 15 0 25
Aux Analog Input Supply Voltage [V]
I
0 s 10 15 20 25

Power.

Power Qutput [W] -

@ COMS 1D MIC3+ 3x1.12 (1.10.1 [0000ac01])  Lifetime: 2:08:37.500 ‘
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The following information is provided:

— CAN State
The status display indicates the current error handling status of the device for the CAN bus
communication:

—  Error Active
The device is in normal state of bus communication. If an error occurs in communication,
the device sends an active error flag.

— Error Passive
After a defined number of errors in bus communication, the device changes to state Error
Passive. If another error occurs, the device sends a passive error flag.

—  Bus Off
The device is disconnected from the CAN bus due to error accumulations in bus
communication.

— Voltages
— Supply Voltage
Current voltage supply of the controller board.
— Pickup Input Pre-Trigger Voltage
Current pre-trigger voltage for the pickup inputs (refer to Engine — Pickups on page 86).
During operation the pre-trigger voltage for passive pickups is increased depending on
the speed, so that the ignition controller is less prone to interferences.

—  Aux. Pickup Supply Voltage
Current auxiliary supply voltage of the pickups (refer to Engine — Pickups on page 86)

— Aux. Analog Input Supply Voltage
Current auxiliary supply voltage of the analog inputs (refer to Timing — Analog Inputs on
page 90)
- Power

- Power Output
Current power output
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8.12.8 Runtime Data — Temperatures

M MICT - Runtime Data

P EH G

Overview ~ Timing  Igniion = BankA  States  Messagelog
Controller Board
Current Temp [*C] - ___ I
-0 0 50 100 150

Min Temp (C] [EY ——————
r—r 1771751
50 o 0 100 150

MaxTemp[’C]- T
T T I
50 0 S0 100 150

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01]) Lifetime: 2:14:10.500

Diagostics

Temperatures

Information

In the window you receive an overview of the temperatures of the controller board. The maximum

and minimum values are reset at each new start of the ignition controller.

The following information is provided:
— Controller Board

— Current Temp.

Current temperature of the controller board

- Min. Temp.

Minimum measured temperature of the controller board

- Max. Temp.

Maximum measured temperature of the controller board
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8.12.9 Runtime Data — Information

M MICT - Runtime Data - [m] X

P EH G

Overview  Tming  Iognibon  BankA  States  Messagelog  Diagnostics  Temperatures  Information

Device

Device ID MIC3+ 3x1.12 (1.10.1 [0000ac01])
Arrangement Number 3C1.12.C0Q0-000-AA-1

Serial Number 01019195

Bootloader Version 0.26.2.20138

Firmware Version 1.12.0.40630

Operating Hours 50:16:41.981

Controller Board

Serial Number 3100008637

Hardware Version 1.4.0.19856

Clock

Date and Time Wednesday, July 14, 2021 10:41:54 AM UTC

& COMS ID MIC3+ 3x1.12 (1.10.1 [0000ac01])  Lifetime: 50:16:41.981

In this view, you can find an overview of the device and version data. If problems arise, you can
print the current runtime data and send them to the MOTORTECH Service Department as a PDF
file by email. For fast support, we will then immediately have all required information.

Rev. 01/2026 127



8 Settings via the MICT

8.13 Log
Click on the symbol to open the window Log. This window is only available to
ﬁ users with authorization for the access level Advanced Service.
8 MICT - Log - o X
B Automatic scroling Log level: dsbug -
Write log to fla:  nja Selact file

23.06.21 10:15 /src/runtime_data/runtime_data.cpp (15%6€) Rebuild firing point list.

23.06.21 10:17 /src/pickup_signal_handler/pickup_signal_handler.cpp (437) select inpucs:
23.06.21 10:17 /src/pickup_signal_handler/pickup_signal_handler.cpp (437) select inpucs:
23.06.21 10:17 /sre/pickup signal handler/pickup_signal handler.cpp (437) select inputs:

-1
oo
o oo

The window Log serves to assist MOTORTECH with error diagnosis.

— Automatic scrolling
If the function is active, the display area focuses on the latest message.

- Log level
The selection of the log level is specified by MOTORTECH if needed.

—  Write log to file
The checkbox activates or deactivates the saving of logged data to a selected file. If the
function is deactivated, the logged data is only displayed.

— Selectfile
With this button, you can select a file to which you want to save the logged data.
If you are prompted to create a log file in the event of a service case, proceed as follows:
1. Open the window Log via the toolbar or the menu bar.
2. Select a path with the Select file button and enter the file name for the log file.
» If the file does not yet exist, it is automatically created with the extension ./og.

Activate the checkbox Write log to file.
Select the level specified by MOTORTECH from the list Log level.
5. Leave the window open.

» The log messages are logged both in the window and in the selected file.
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|

NOTICE

Date and time of ignition controller

The date and time can be individually configured for each ignition
controller and saved in the device. The device does not adjust
automatically for daylight savings time. Hence, deviations may occur
between the device time and the time settings of the computer used for
accessing the device.

Correspondingly, the times indicated for the states, messages, and in the
log reflect the time of the ignition controller. The current time of the
ignition controller is shown in the view Runtime Data — Information. You
can adjust the time of the ignition controller by entering the desired time
in the menu via Device -> Set date and time.

8.14 Runtime Adjustments

|
|7

|

NOTICE

Rev. 01/2026

Click on the symbol to open the window Runtime Adjustments. This window is only
F available to users with authorizations starting at access level Service.

Runtime adjustments are implemented directly

All runtime adjustments are implemented directly without requiring the
input to be confirmed and are retained even in the case of an MIC3+
restart.

Changes that have been saved in the device configuration are only
displayed after re-uploading the device configuration in the MICT's main
window.
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8.14.1 Runtime Adjustments — Reset
M MICT - Runtime Adjustments - (m} X

Resst  Tming  Energy  Secondary Voltage Calbraton  Secondary Short Calibration
Reset [*CRANK] - RET

@osaov € 0140y Y oirer Wosrer

@ COMS D MIC3+ 3x1.12(1.10.1 [0000ac01)) .

The index/reset position can be corrected by 5 °crankshaft (advanced/retarded) while the device
is being operated. The correction is made with the buttons:

- 0.1 ADV/RET
in 0.1° increments to advance or retard

- 0.5 ADV/RET
in 0.5° increments to advance or retard
Changes are implemented immediately and stored in the configuration located in the device.

If the correction range is not sufficient, the reset/index position must be adjusted in the
configuration (refer to Engine — Pickups on page 86).
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8.14.2 Runtime Adjustments — Timing
M MICT - Runtime Adjustments. - (m} X

Reset Tming  Energy  Secondary Voltage Calbration  Secondary Short Calibration
Timing Correction [*CRANK] - ADV
Globa Timing Point (-craneq [N ~ov

@osav € o140y P oirer Wosrer

@ COMS D MIC3+ 3x1.12(1.10.1 [0000ac01)) .

The global ignition timing position can be corrected by 50 °crankshaft (advanced/retarded) while
the device is being operated. The correction is made with the buttons:

- 0.1 ADV/RET
in 0.1° increments to advance or retard

- 0.5 ADV/RET

in 0.5° increments to advance or retard
The limit for the ignition timing set in the schedule (refer to Timing — Schedule A/B — General on
page 91) cannot be exceeded or not reached with the runtime adjustment.

The correction of the global ignition timing is immediately implemented and also remains in place if
the device is restarted. NOTICE: The configuration defined in the device is not changed.
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8.14.3 Runtime Adjustments — Energy
M MICT - Runtime Adjustments. - (m} X

Reset Tmng  Energy  Secondary Voltage Calbration  Secondary Short Calibration

Schedule A
spark ouraton (<] SIS
K-0ps || €-1ps i (B
spark ntensity [ma] | RSN
&-1oma | € -1ma diima (P srwoma
Schedule B
sparkourason (oe] [N
&-0ps | €1 P rios P
spark tntensity (ma) [ EEN
&-1oma | €-1ma P +ima B roma

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01)) .

The energy settings can be separately adjusted for both schedules. Changes are implemented
immediately and stored in the configuration located in the device.

Spark Duration
- +/-1us

lengthen or shorten in microsecond increments
- +/-10 pus

lengthen or shorten in 10 ys increments

Spark Intensity
- +/-1mA

increase and decrease in milliampere increments
- +/-10mA

increase or reduce in 10 mA increments
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8.14.4 Runtime Adjustments — Secondary Voltage Calibration
M MICT - Runtime Adjustments. - (m} X

Reset Timing Energy Secondary Voltage Calibration Secondary Short Calbration

All Outputs

L &-os || €-01 || Reset | Daor || Pros

2
n
=
e

W W (W W W (¥ W ¥ e

,..
e
e
w

Oulput
Al

A2
A3
A4
AS
A

A7

& AR AR AR AR R R R E
Al A A Al alla alla e
¥ ¥ ¥

A3

@ COMS IDMIC3+ 3x1.12(1.10.1 (0000ac1)) .
The secondary voltage estimation can be calibrated in this window when using ignition coils that
support this function:

A correction value without units can be set for the secondary voltage estimation for every output
to increase the accuracy of the secondary voltage estimation for each individual cylinder. This
allows, for instance, different cable lengths on the engine to be compensated.

The secondary voltage estimation should be calibrated under full load at a nominal speed. The
adjustment can be made globally or individually for each cylinder using the respective buttons.
The value range depends on the set ignition coil. 0.0 is set as the standard value for all cylinders.

Changes are implemented immediately and stored in the configuration located in the device.
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8.14.5 Runtime Adjustments — Secondary Short Calibration
M MICT - Runtime Adjustments. - (m} X

Reset  Timing Energy Secondary Voltage Calibration Secondary Short Calibration

Secondary Short Enable Voltage
‘Secondary Short Enable Voltage [kv] I - Reset
Secondary Short Sensitivity
Secondary Short Sensitivity _ Reset
b o1 b o001 | b oo | o 0.0001
== Q.1 == .01 == 0.001 == 0.0001

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01)) .

The starting voltage and sensitivity for the secondary short-circuit detection can be adjusted.
Changes are implemented immediately and stored in the configuration located in the device.

Secondary Short Enable Voltage [kV]
Set the necessary average ignition voltage required to activate the secondary short-circuit
monitoring:

— The secondary short detection is always activated at a value of O kV.
— The secondary short detection is always deactivated at a value of 65.535 kV.

Secondary Short Sensitivity
The permitted value range depends on the set ignition coil.

Set the sensitivity of the short-circuit detection e.g. as follows:
— The sensitivity is high at a value of 0.98.
— The sensitivity is low at a value of 1.02.
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Adjust the sensitivity of the short-circuit monitoring
If a short-circuit is misdiagnosed at a sensitivity of 1.00, the sensitivity
must be set to 1.02.

If a short-circuit is not detected at a sensitivity of 1.00, the sensitivity

SLlHLE must be set to 0.98.

8.15 Cylinder Individual Offsets

Click on the symbol to open the window Cylinder Individual Offsets. This window is
only available to users with authorizations starting at access level Service.

B! MICT - Cylinder Individual Offsets — a x
ADV RET

A Offset [ 0.5 0.1 0.1 0.5
A1 R == « € b *»
e B %€ € b »
3 I = « € b4 b3
A4 I « € b4 »
s I = €« € > »
4 I - « € » »
a7 ) = € € b4 @
A8 I = « € b4 »
) I = &« € » »
A10 I = &« € b3 »
A1l I == « € ¥ »
Az B = &€ € > »

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01]))

The cylinder individual offset can be applied to the position of the timing point while the controller
is being operated. Offset via keys:

- 0.1 ADV/RET
in 0.1° increments to advance or retard

- 0.5 ADV/RET
in 0.5° increments to advance or retard

The adjustment option of this function is limited by the specified settings in the configuration.
Refer to the section Timing — Schedule A/B — General on page 91.
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Immediate execution of the changes

i Please note that changes made to the timing point are executed

immediately at the next firing of the corresponding cylinder. The
maximum performed change per cycle is however limited by the
NOTICE corresponding setting in the configuration. For this read Timing —
Miscellaneous on page 94.

Save changes automatically
. Please remember that changes to the ignition timing are saved

1 automatically.

NOTICE
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8.16 Schedule Curve
Click on the symbol to open the window Schedule.

8.16.1 Schedule Curve — Simulation

M MICT - Schedule - a b4
Simulation 15.0 BTDC
smulation 2
Potentiometer
@60 ]
» X a0 J
’J) - AV 10.0 BTDC
0 100 g
T\ T
Analog Current Input — 1 H
¥
0 ra b B
<
S~/ dN 5] 1
- RET E, 5.0 BTDC
o 4. 9 ol
£ o -
-
£ 1 i
Analog Voltage Input [ ;_’,/ H
4 6
0.00V 2 :
2 P CXTT
0.0 ATDC
Py T
0 10
Schedule
© Schedule A Schedule B
Timing Point
- BTDC 5.0 ATDC — >

v T—— T T — v T T 1

0 500 1,000 1,500 2,000 2,500
Speed [RPM]

— MinTiming — MaxTiming — Min Speed Curve Timing — Max Speed Curve Timing — Speed Curve @ Current speed

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01])

The schedule curve visualizes the configurations of the schedules and simulates the influence of
the inputs over the speed range. With the optional input fields, you can switch between schedule
A and B. Changes made by turning the control buttons or entering the desired values are
displayed simultaneously.

— Simulation
The simulation is activated or disabled using the checkbox.

— Potentiometer
Simulation of the potentiometer

— Control button for adjustments between 0 % and 100 %
— Field for manual input of the desired value in %
— Displays the value in °crankshaft by which the timing is offset
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— Analog Current Input
Simulation of the analog current input

— Control button for adjustments between the configured values (e.g. 0 mA and 20 mA)
—  Field for manual input of the desired value in mA
— Displays the value in °crankshaft by which the timing is offset
— Analog Voltage Input
Simulation of the analog voltage input
— Control button for adjustments between the configured values (e.g. 0 V and 10 V)
— Field for manual input of the desired value in V
— Displays the value in °crankshaft by which the timing is offset
— Schedule A/B
Select between Schedule A and B
— Timing Point
Displays the global ignition timing as it changes during the simulation.

While connected to the device, the ignition timing is simulated depending on the actual engine
speed and marked as ® in the diagram.
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8.16.2 Schedule Curve — Runtime Values

If the checkbox Simulation is unchecked, the Schedule curve window switches to the current
runtime data.

M MICT - Schedule - a X

() simutation 15.0 BTDC
Runtime Values - =
Schedule

Schedule: A
Potentiometer

I - I = . - S
Analog Current Input 10.0 BTDC ot o
D - I "
Anglog Voltage Input
I - I
Spead

I -

Timing Point

I o

5.0 BTDC

Timing [°CRANK]

0.0 ATDC

5.0 ATDC

— —_— —_— —_— —_— . .
0 500 1,000 1,500 2,000 2,500
Speed [RPM]

— MinTiing — Max Timing — Min Speed Curve Timing — Max Speed Curve Tining — Speed Curve @ Current speed

@ COMS D MIC3+ 3x1.12 (1.10.1 [0000ac01])

The following information is provided:
— Schedule
Displays the currently selected schedule.
— Left column: Potentiometer, Analog Current Input, Analog Voltage Input
Displays the new calculated adjustment values for the potentiometer, current and voltage
input.
— Right column: Potentiometer, Analog Current Input, Analog Voltage Input
Display of values supplied by the ignition controller for the potentiometer, current and voltage
input.
- Speed
Display of the current speed
— Timing Point
Displays the current global ignition timing.
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8.17 Coils
The MICT has a database with technical information on MOTORTECH ignition coils. Open the
database as follows:

Tools -> Coils

You have the option of storing and printing information on the ignition coils present in the
database. For this purpose, the following functions are at your disposal in the toolbar in the Coils
window.

Symbol Function

Stores the information on the selected ignition coil in a format that is appropriate
for configuring the MIC3+ via fieldbus.
Prints the selected coil data set.

Prints the selected coil data set as PDF file.

Opens the print preview.

Coils
— Device

Select an ignition controller.
- Call

Select an ignition coil.

Select the correct ignition controller

i The ignition coil data depends on the ignition controller used. Always

select the ignition controller for which you are using the coils in order to
obtain the correct data.

NOTICE
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8.17.1 General
M MICT - Coils - o X
Eile
o s
Cols General  Min, Energy Limit Curve
Device: MIC3+ N Detals

Col: [ 06.50.003 Name: 06.50,104
06.50.035 Col Type Id: 6

06.50.055 Data Version: 2
06.50.065

06.50.100
06.50.102
[06.50.104
06.50.105
06.50.107
06.50.108
06.50.112
06.50.113
06.50.145
06.50.146
06.50.147
06.50.148
06.50.155
06.50.156
06.50.157
06.50.158
06.50.162
06.50.165
06.50.300 =

Secondary diagnostics avalable if max. breakdown voltage is set i range 38 kV to 40 kv. Additonaly it s requred
06.50.301 that the energy fmit & set sufficently high according to the min. energy it curve.

93.09.150 et
95.08.003
95.08.040-6 Parameter Min. Max.

95,08.050-14.5 Max. Breakdown Voltage [kv] 19 40
95.08.222-12 Spark Intensity [ma] 32 190
95.08.222-6 Secondary Voltage Estmation Calbration 5 H

95.09.005 Secondary Short Sensitivity 0.8 02
95.00.024-11

Details
The following information is provided:

- Name
Coil name

— Coil Type ID
Used to clearly identify the ignition coil

— Data Version
Shows data version of the ignition coil selected in the database. The data version of the
ignition coil configured in the ignition controller is displayed in the runtime data in the view
Ignition (refer to Runtime Data — Ignition on page 108). The Automatic Online Update should be
activated to ensure that the coil database always has the latest data sets. Additional
information on the online update is provided in the section Online Update Settings on page 66.

— lllustration of the ignition coil

— Information on the conditions under which a secondary diagnosis is possible using the
displayed ignition coil.
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Coil Parameters
The following information is provided:

142

Max. Breakdown Voltage [kV]

Displays the permitted value range for the maximum breakdown voltage in kV. The maximum
breakdown voltage is configured in the view Timing — Schedule A/B — Energy (refer to Timing
— Schedule A/B — Energy on page 93).

Spark Intensity [mA]

Displays the permitted value range for the spark intensity in mA. The spark intensity is
configured in the view Timing — Schedule A/B — Energy (refer to Timing — Schedule A/B -
Energy on page 93).

Secondary Voltage Estimation Calibration

Displays the permitted value range for the secondary voltage estimation calibration. The
calibration of the secondary voltage calibration takes place in the view Engine — Ignition Coils
(refer to Engine — Ignition Coils on page 84) and in the runtime adjustments (refer to Runtime
Adjustments — Secondary Voltage Calibration on page 133).

Secondary Short Sensitivity

Displays the permitted value range for the calibration of the secondary short sensitivity. The
calibration of the secondary short sensitivity takes place in the view Engine — Ignition Coils
(refer to Engine — Ignition Coils on page 84) and in the runtime adjustments (refer to Runtime
Adjustments — Secondary Short Calibration on page 134).
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8 Settings via the MICT

8.17.2 Min. Energy Limit Curve

M MICT - Coils - o X

Eile

HIHH

b Genersl  Min. Energy Limit Curve

Device: MIC3+ N Min. Energy Limit Curve

Col: [ 06.50,003 260
06.50.035 ]
06.50.055
06.50.065
06.50.100
06.50.102
06:50.104
06.50.105
06.50.107
06.50.108
0650112
0650113
06.50.145
06.50.146
06.50.147
06.50.148
06.50.155
0650156
06.50.157
06.50.158
06:50.162
06.50.165
06.50.300 100
06.50.301 -
93.08.150 S
95.08.003 ]

95.08.040-6 a0
95.08.050-14.5 i T T T - :

.08.222-12
gmzm Max. Breakdown Voltage [kV]

95.09.005 [ ~ Min. Energy Limit 1 Min./Max. Limit Secondary Diagnostics
25.00.074.11

Min. Energy Limit [m3J]

Min. Energy Limit Curve

The curve provides information on the energy in mJ necessary to achieve a certain maximum
breakdown voltage in kV. The two vertical bars show the breakdown voltage area, in kV, in which
a secondary diagnosis is possible. The corresponding energy settings can be found in the view
Timing — Schedule A/B — Energy (refer to Timing — Schedule A/B — Energy on page 93).

When printing the coil data set, the curve values are also provided as a list.
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9 Operation

9.1 Start-up
Before you start up the MIC3+ ignition controller, take note of the following:

Were the correct engine, ignition sequence, and output configuration selected? If you are
unsure, contact MOTORTECH or the corresponding engine manufacturer.

Ensure that the firing order of the engine and/or the wiring of the output cable harness are
carried out correctly.

Is the wiring of all pickups compliant with the drawings given in this operating manual?

Are the distances of the pickups to trigger discs, reluctor pins, etc. correctly set (see chapter
Determine the Installation Location of the Pickup on page 30)?

Ensure that the data were transferred flawlessly to the controller.

Check whether the start/stop input is set to Firing Active, or whether it works according to
the control requirements of the master control.

Check whether the input contact for parameter settings A/B (Schedule A/B) functions and
ensure that the correct schedule (A or B) was selected for start-up.

Close the service screw and the service cover after completing the installation and
configuration.

Ensure that no gas is present in the inlet and exhaust systems before you start the engine.
Ensure that the gas valve is closed.

Perform the normal engine start-up process while the gas valve is closed (start only).

Connect a stroboscope to the first firing cylinder (cylinder #1) and check whether the timing
point set on the ignition controller coincides with the actual timing point on the crankshaft. If
the ignition timing does not coincide exactly, change it (see chapter Runtime Data on page
103) until the optimal setting is reached. If the ignition does not fire, read the instructions in
section Troubleshooting on page 150.

Check all other cylinders for correct ignition. If they are not correct, stop the engine, and
recheck wiring and ignition sequence for correctness.

Stop the starting process. If no problems occur, start the engine in accordance with the
specifications of the engine manufacturer.

9.2 Shutdown

The ignition controller is shut down by disconnecting it from the power supply.

144
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9 Operation

9.3 Firmware Update
Using the MOTORTECH Flash Tool, you can update the firmware of the ignition controller. The
program is provided on the storage device (USB flash drive or CD-ROM supplied).

Install MOTORTECH Flash Tool
Install the MOTORTECH Flash Tool as follows:

1. Start the installation:

— Viathe menu:
Start the file Start.exe on the storage device. Start the installation routine for the
MOTORTECH Flash Tool via Software -> MOTORTECH Flash Tool -> Install MOTORTECH
Flash Tool.

— Directly from the storage device:
Start the installation routine of the MOTORTECH Flash Tool directly. It is on the storage
device in the subdirectory Installation and for example named as follows: MOTORTECH-
Flash-Tool-0.23.00000-setup.exe.

2. Install the program.
Follow the instructions of the installation routine. Note that the license agreement terms must
be accepted before using the MOTORTECH Flash Tool.

3. If the USB driver is not yet installed, also install it via the menu or directly from the storage
device.
— Viathe menu:
Software -> USB Drivers -> Install USB Drivers

— Directly from the storage device:
Start the exe file in subdirectory Drivers
(e.g. CDM21226_Setup.exe).

» The MOTORTECH Flash Tool is set up. You can now connect your computer to the
ignition controller via the USB interface.

Menu Bar and Toolbar
After launching the MOTORTECH Flash Tool, the following functions are available to you via the
icons on the toolbar and the entries in the menu bar:

Symbol Menu Function

= File -> Open Opens a firmware file.

File -> Quit Exits the program.
View -> Extended file Fades in/out additional information of the
information view firmware file.
View -> Extended connection Fades in/out additional information and settings
settings of the connection to the device.

Q View -> Reload file Reloads the file information of the selected

1 firmware file.
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9 Operation

Symbol Menu Function

@ Device -> Search devices Restarts the search for connected devices.

%;h Device -> Flash device Starts the update or downgrade process.
]

Settings -> Language Opens the window Select Language in which
you can change the interface language of the
program.

Help -> Help Opens the online help.

Help -> About MOTORTECH Opens detailed information on the program.

Flash Tool

Start Firmware Update

Access control for firmware update

If you have activated the access control for the ignition controller, you
1 need the PIN for the level Master for the firmware update. For more

information read the section Access Control for MIC3+ on page 71.
NOTICE

Backup the existing configuration

i Your device's configuration may be lost if the firmware update is not

performed properly. Always backup the existing configuration via the
MICT prior to performing an update. For more information read the
NOTICE section Working with Configurations on page 73.

To start a firmware update, proceed as follows:
1. If an MICT is connected with the ignition controller, disconnect this connection.
2. Start the MOTORTECH Flash Tool on your computer.
» The program is started and automatically checks all ports for connected devices.

3. Inthe Status section under Device, check if your device has been recognized properly.

» If the MOTORTECH Flash Tool does not recognize a device that is connected to your
computer via the USB interface, you can usually still carry out a firmware update. To do
so, observe the instructions in the information windows of the MOTORTECH Flash Tool
for the following steps.

4. Inarea File, select the desired update file using the Select button.
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Use the file information displayed to ensure that the update is correct for your device.
Start the update process using the Flash button or using the menu or toolbar.
> Theignition controller is restarted automatically.
> Now, a window opens informing you about the firmware version currently used on your
ignition controller and also about the relevant update version.
7. Confirm with Yes to proceed with the update process.
> The update will start.
> A message will confirm that the firmware update was successful.

8. After a successful firmware update, check all configuration data.

Downgrade process

-4 The process for downgrading is largely the same as for updating. You will

1 only be notified that newer firmware is installed on the device.

NOTICE

Help with connection problems

e If a correctly connected device cannot be found during the automatic
1 search, this may, for example, be because too many communication
interfaces are occupied and need to be checked. In this case, an interface
NOTICE can be selected from the drop-down list Port in the area Connection and

therefore specified.

If the desired port is not yet displayed in the list or if the problem persists,
adjusting the connection timeouts may help. The time-out settings are
displayed in the main view by selecting the following entry in the menu
bar: View -> Extended connection settings

Make the following settings:

— Update Request Timeout
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms.
Extending the timeout can be particularly beneficial in the event of
connection problems caused by the computer having many occupied
ports.

— Start Timeout
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms.
Changing the timeout can be particularly beneficial in the event of
connection problems caused by disrupted communication between
the computer and the device.
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10 Errors

10.1 Possible Faults
The MIC3+ ignition controllers include several safety functions that can shut down the engine in
case of fault:

— Overspeed protection

— External shut-down contact (Start/Stop)

- Misfire detection (primary)

— Internal failure of the high voltage supply

—  Output Error Detection

— Shut down in the case of a faulty pickup or faulty pickup signals.
- Alarms

— Faulty voltage supply

— External EMI signals

10.2 Causes of Faults

10.2.1 Overspeed

The engine speed has exceeded the set overspeed value. As of firmware version 1.11.00000, an
operating error caused by overspeed is indicated on the device by the status LED flashing four
times (4 times red/off 250 ms, 750 ms off). Refer to the section LED Functions on page 24.

Potential Causes
— Speed controller does not function properly

—  Fuel supply to engine is not optimal.
— Faulty pickup signal

10.2.2 Output Error Detection
An internal failure of the high voltage supply or a defective output switch occurs.

Potential Causes
— Hardware fault on the MIC3+

— Defect in the wiring (short circuit or open circuit)

10.2.3 Misfire Detection (Primary)
Misfiring due to an open circuit on the primary side was detected and displayed in the runtime
data.

Potential Causes
— Defect in the output wiring

— Ignition coil defective
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10 Errors

10.2.4 Pickup Input Errors

Faulty input signals from the pickups are detected. As of firmware version 1.11.00000, an pickup
input error is indicated on the device by the status LED flashing two times (2 times red/off 250 ms,
750 ms off). Refer to the section LED Functions on page 24.

Potential Causes
— Number of teeth on the flywheel does not match the set number.

— Damage to or uneven running of trigger disc
— Interference in the wiring of the pickup

- Wiring of the pickup incorrect

— Distance of the pickup incorrect

— Dirt on the pickup

Troubleshooting for Possible Causes

You will find information on possible causes of a pickup input error in the windows Runtime Data —
States (see Runtime Data — States on page 110) and Runtime Data — Message Log (see Runtime
Data — Message Log on page 116). When analyzing the messages shown there, please note that the
number of the pickup (e.g. PU2) only names the pickup at which the error or problem was
identified. Hence, this does not mean that this particular pickup also caused the problem. For
example, if the pickup PU1 is defect, it is entirely possible that, under certain circumstances, the
problem may only be identified at pickup input PU2.

For information on the numbers shown in the error messages (e.g. PU1=0x00001002), refer to the
documentation on the pickup status bits on the storage device enclosed with the ignition
controller. You can open the file via the menu: Documentation -> More information.

For a more in-depth analysis of the problem, the pickup traces may support you. Refer to the
section Pickup Trace on page 69. Compare the signals recorded there with the pickup settings in
your configuration (see Engine — Pickups on page 86).

10.2.5 Faulty Voltage Supply

If the supply voltage falls below the 16.8 V required for safe operation of the ignition controller,
error messages may appear. As of firmware version 1.11.00000, an operating error on the device
caused by insufficient supply voltage is indicated by the status LED flashing five times (5 times
red/off 250 ms, 750 ms off). Refer to the section LED Functions on page 24.

Potential Causes
— The power supply is dimensioned too small.

— The battery is worn out.
— The wiring for the power supply is defective.
— The wiring for the power supply is routed incorrectly.
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10 Errors

10.2.6 Acknowledging Faults
While the engine is in standstill, you have the following options for acknowledging operational
errors:

— Via Acknowledge Operational Error in the MICT
— Acknowledgment of the error via CAN bus or RS485
— By disconnecting the supply voltage

10.3 Troubleshooting

10.3.1 Running a Self Test
You can run the self test via the MICT to check the order of the wiring and the connection between
the ignition controller outputs and the spark plugs. For this refer to section Self Test on page 67.

From firmware version 1.11.00000, the running self-test is indicated on the device by the status
LED flashing once (1 time orange 250 ms on, 750 ms off). Refer to the section LED Functions on
page 24.

Operational safety!

If you carry out a self test, it is essential for the gas supply to be switched
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons.

10.3.2 Customer Service Information
You can reach us during our business hours by:

Phone: +49514193990

Email: service@motortech.de (technical support)
sales@motortech.de (all other matters)

10.3.3 Returning Equipment for Repair/Inspection

To return the device for repair and inspection, first consult your MOTORTECH contact person (see
Customer Service Information on page 150). From him you will receive all the information you need
to process your order quickly and smoothly. For return shipment, also observe the instructions in
the section Instructions for Packaging the Equipment on page 150.

10.3.4 Instructions for Packaging the Equipment

For return shipment, equipment should be packaged as follows:

— Use packaging material that does not damage the equipment surfaces.
— Sturdy packaging of the device

— Use sturdy adhesive film to seal the packaging.
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11 Maintenance

11.1 Maintenance Instructions
Please follow the following maintenance instructions:

— Do not use caustic liquids or steam cleaners for cleaning the device.
— Clean the passive pickups at regular intervals.
— Check the ignition wires at regular intervals.

— Replace the pickups at regular intervals if operating them under elevated temperature
conditions (> +90 °C / > +194 °F).

— Regularly inspect all wires of the ignition system for damage and replace the wires as needed.
— Check all plug-in connections for proper condition.
— Service the spark plugs as per the instructions of the spark plug and engine manufacturers.

11.2 Spare Parts and Accessories
For spare parts and accessories for MIC3+ ignition systems, please refer to our current Product
Guide, which is available for download on the Internet at www.motortech.de.
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